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Overview

The 1B9391 and 9365 series is a camera line to come embedded with the Smart Motion
Detection feature. The Smart Motion detection, with Human detection and tunable time
filter, can eliminate the defects of traditional motion detection and facilitate the configuration
at a surveillance site.

To learn more about this feature, download its User Guide in:
http://download.vivotek.com/downloadfile/solutions/vadp/smart-motion-detection-manual_
en.pdf

A key feature in the Smart Motion detection is the Human detection. Based on a human
silhouette database and the rapid responses via an artificial neural network technology,
the Smart engine instantly recognizes human appearances in a video surveillance area.
Since humans are the objects of interest in the majority of video surceillance, the Human
detection feature enables users to quickly configure his installation.

With Human detection, light changes or swaying vegetation, vehicles passing by, or animal
activities in the scene are not taken as event triggers. Only human activities will trigger an
event. This helps reduce false alarms and the time and efforts for a camera configuration.

The 9365 series is an outdoor network camera capable of 1920 x 1080 resolution at 60
fps. With the most updated VIVOTEK SNV and WDR Pro technology, the 9365 series
is capable of capturing the highest quality images in both low light and high contrast
environments. The IB9391 features an 8MP resolution.

The 9391 and 9365 series also offers the best in night time surveillance technology. By
adopting Smart IR Il technology from VIVOTEK speed domes, the IR illuminators now
align with the remote focus lens’ focus angle to provide the best IR image quality at any
lens setting. This feature optimizes IR intensity, reduces IR hotspots, and increases the IR
effective range up to 50 meters.


http://download.vivotek.com/downloadfile/solutions/vadp/smart-motion-detection-manual_en.pdf
http://download.vivotek.com/downloadfile/solutions/vadp/smart-motion-detection-manual_en.pdf

Revision History

m Rev. 1.0: Initial release.

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal before
installing this unit for its intended use.

It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the Network
Camera is installed; then carefully read and follow the instructions in the Installation chapter to
avoid damage due to faulty assembly and installation. This also ensures the product is used
properly as intended.

The Network Camera is a network device and its use should be straightforward for those who
have basic networking knowledge. It is designed for various applications including video sharing,
general security/surveillance, etc. The Configuration chapter suggests ways to best utilize the
Network Camera and ensure proper operations. For creative and professional developers, the URL
Commands of the Network Camera section serves as a helpful reference to customizing existing
homepages or integrating with the current web server.

£\

Caution! Hot surface! Do not touch.

/\ IMPORTANT:

1. Disconnect power from the unit when performing a maintenance task.

2. RTC battery:

a) Replacement of a battery with an incorrect type that can defeat a safeguard (for
example, in the case of some lithium battery types);

b) Disposal of a battery into fire or a hot oven, or mechanically crushing or cutting of a
battery, that can result in an explosion.

c) Leaving a battery in an extremely high temperature surrounding environment tha can
result in an explosion or the leakage of the flammable ligurid.

d) Abattery subjected to extremely low air pressure that may result in an explosion or
leakage of flammable liquid or gas.

Please contact VIVOTEK's certified dealers for power adapters.

2. Installation and maintenance service should only be performed by qualified technicians.
3. If powered by a power adapter, the adapter should be properly grounded.

4. The power cord must be connected to a socket or outlet with a ground connection.



NOTE:

Camera Hardware Preventative Maintenance:
1. Visual inspection of all major components including accessories, cabling and

connections where accessible for signs of deterioration or damage.

2. Check and clean cameras, lenses and housings inside and out as needed.

Please do not scratch, damage, or leave fingerprints on the dome/front cover and/or
lens because this may decrease image quality.

For general cleaning of dirty areas, it is suggested to use compressed air to remove
dust and/or other debris in order not to damage the on-board components.

In order to clean oil stains, it is recommended to use a spray-type decomposing cleaner
(absolutely avoid reciprocating wipes on the surface). After the oil has decomposed,
spray it with water, dry with air, and/or absorb water with a cotton cloth or a soft cloth
(dab, please avoid wiping).

Do not use harsh detergents, gasoline, benzene or acetone, etc. to clean as they may
deform or cause damage to the product. Also, excessive cleaning could damage the
surface.

Check images for correct field of view (pan, tilt and zoom focus) and adjust as
necessary.

Check and replace the Micro SD memory card as needed.

Stop edge recording before removing the Micro SD memory card.

Make sure that the Micro SD memory card is right side up and do not insert it with
force, otherwise it may be damaged.

When it is raining or the humidity is high, insertion or ejection of the Micro SD memory
card is not recommended.

Disassembly of the dome/front cover carries the risk of internal dew condensation, so
please remember to replace the desiccant bags on the inside of the cameras before
reassembly.

Check that the camera view has not been blocked by obstacles and that you can see
the property perimeter clearly.

Make sure the interiors of cameras and accessories, like mounting kits and/or
enclosures, are clean and dry.

Make sure cameras are securely attached to the wall/ceiling/mounting kits.
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/\ IMPORTANT:

For some customers who already have their own web site or web control application, the
Network Camera/Video Server can be easily integrated through URL syntax. This section
specifies the external HTTP-based application programming interface. The HTTP-based
camera interface provides the functionality to request a single image, control camera
functions (PTZ, output relay etc.), and get and set internal parameter values. The image
and CGl-requests are handled by the built-in Web server.

* To send URL commands in the address bar of your web browser, please remember to
disable the Cross-Site Request Forgery (CSRF) protection in Configuration > Security
> Miscellaneous.

Home Client settings eLL[IeLGLE Language
Security > Miscellaneous

System

Media [[] Enable Cross-Site Request Forgery(CSRF) protection.

Network We strongly recommend not to disable this protection. Disabling this feature will expase your

camera [o risks.
Security

User accounts.

HTTPS
Access list
|IEEE 802.1x

Miscellaneous

PTZ

Event
Applications
Recording

Storage

Version: 0100h

* For up-to-date documentation of URL commands, please go to VIVOTEK’s website,
register an account with a business mail address and submit for authorization for SDK
in Support > Downloads > SDK.

% VIVOTEK Products Solutions Pariners About Us Investor Relations Where to Buy
Cybersecurity Downloads
Support * Cerfificate * Brochure
* ARE * Flyer
Learning s Product Files * Successful Cases
Tools s Firmwaire s Video Library
* Software * Webinar
Legacy Products * SDK *+ White Paper
Cybersecurity Corporate
» Hardening Guide s VI Guidelines

* Green Ceriification

* Logo

* For any further technical support, please contact our technical support department.
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Package Contents

m 1B9391 or IB9365

m Screw pack, sun shield, penetration cap, I/O combo cable, base plate.
m Alignment sticker. m Mounting plate.m Conduit bracket

m Quick Installation Guid e.

m T20 wrench. .

/\ WARNING:

1. IR lights emit from ths product.
2. Use live view to verify if the IR lights are on in the night mode.

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent
inconvenient or problem situations.

% NOTE: Notices provide guidance or advices that are related to the functional integrity of
/__ the machine.

1N

N Tips: Tips are useful information that helps enhance or facilitae an installation, function,

Oor process.

WARNING: or IMPORTANT:: These statements indicate situations that can be
dangerous or hazardous to the machine or you.

Electrical Hazard: This statement appears when high voltage electrical hazards might
occur to an operator.

> B

/\ IMPORTANT:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed I.T.E. with PoE output.

1. La caméra ne doit étre raccordée qu’'a des réseaux PoE, sans routage vers des
installations extérieures.

2. Pour les raccordements PoE, utilisez uniquement un équipement de Tl homologué UL,
avec une sortie PoE.

Use the camera only with a DC power supply that is UL listed, and limited power source
(LPS) certified. The power supply should bear the UL listed and LPS marks. The power
supply should also meet any safety and compliance requirements for the country of use.

n’utilisez la caméra qu’avec un bloc d’alimentation CC homologué UL, ainsi qu’avec
une alimentation limitée (LPS) certifiée. Le bloc d’alimentation doit porter les indications
d'homologation UL et LPS. Il doit également répondre aux exigences en matiére de
sécurité et de conformité relatives au pays d’utilisation.

User's Manual - 7
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Physical Description

Outer View

Sun shield

Many copper coated aluminum (CCA) and other non-standard conductors cabling products
are masqueraded as CAT5E or CAT6 cables. Please avoid using these CCA products
especially when cascading PoE cameras. It is a must to use Ethernet cables compliant
with the 3P/ETL standard.
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Inner View

LEDs MicroSD card slot

—

e ' N
o K/_] g
STATUS MICRO SD
o » Micro USB connector
RESET  micro uss for Wi-Fi dongle

» Reset button

L

.

Conn 1 DI/DO connector Conn 2 Audio connector
Ethernet port
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J NOTE:

Some of the suffix syntax used in model naming are listed below:

w/ heater for extreme weather

Focal length w/ number

w/ Remote focus lens

w/ PoE repeater

w/ High Dynamic Range functionality

Z|T|A|H|mm

Manual focus lens

/\ IMPORTANT:

802.3af or 802.3at

ar SN,
iwve;

uuuuu

s 0
o o

switch.

:

The E model camera comes with an embedded heater and requires an 802.3at PoE

Consumption & Power Input

IB9391-EHTV-v2

IB9365-EHTV-v2

PoE 802.3at Class 4 - 42.5V/0.44A 18.7W,
57V/0.34A 19.38W (PoE midspan or
endspan)

PoE 802.3at Class 4 - 42.5V/0.51A 21.68W,
57V/0.39A 22.23W (PoE midspan or
endspan)

DC 12V - 15.84W 1.32A

AC 24V - 16.52W 1.11A

DC 12V - 17.28W 1.44A
AC 24V - 17.26W 1.16A
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Hardware Installation

/\ IMPORTANT:

If you plan to use the Human Detection feature, make sure you measure the installation
height of your camera. The height information is important for the accuracy of the video
analytics results. Some of the other perspective information are automatically collected by
the onboard S-sensor. The height information enables the horizontal and vertical keystone
corrections of the field of view. Measure the distance between camera lens and the
ground.

Measured to the
approx. lens position.
Not to the ceiling.

Installation
height

1.Jot down the camera's MAC address for later reference.

é )

Network Camera VIVOT=K

MAC: 0002D1083236
E RoHS

—-—
This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions:

(1) this device may not cause harmful interference, and

(2) this device must accept any interference received, including interference
that may cause undesired operation

L Pat. 6,930,709 Made in Taiwan

User's Manual - 11




VIVOTEK

2.Use the alignment sticker to drill holes on the wall.

If the use of an 1/2" conduit pipe is
preferred, refer to the Installation
option A.

12 - User's Manual
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3.Route cables through the wall or ceiling, and remove the grommet on the base plate.

4.Remove the tip of the silicon grommet. Insert the RJ45 connector of your Ethernet cable
into the penetration cap.

L

CC——

5~8mm %\

User's Manual - 13
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5.Insert and pass the cable through the silicon grommet.

If grommets are damaged, replace them with new
ones.

CONN1
CONN2

14 - User's Manual
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7. When installing the silicon grommet, make sure the cable is slightly pulled back to the
outside. Do not leave the rim of the seal jammed in the inside of the seal.

¥

8.The 1/0 combo cable comes with a pre-installed grommet. Install the cable to the
opening and place I/O wires in the cable clip. Note the orientation of the 1/0 pin headers.

If you want to use the
extension 1/O kit, refer to
Installation option B.

Extension I/O kit
Separately purchased

User's Manual - 15
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9. Below are the pinouts of the I/0O combo cable. If you prefer more audio, DC, and I/
O connections, you can purchase and install an extension kit. Refer to the installation
option B section for more information.

[ )

DI-: Yellow

DI1+: Blue

DO1-: Orange
DO+(12V): Brown

-

10. All cabling joints on the outside of the camera must be properly sealed for
waterproofing.

Use a crimping plier to connect a grounding wire to the ground screw following the
instructions below.

1. Stretch the waterproof tape by twice its length and = . =

wind around the cables. S 7 ©) g!@ \

2. The tape should overlap the cable joints by 20mm. / 74 '/

3. All connectors, whether they are used or not, / \ (/}

should be waterproof. [ I~ ‘
Cable molding _ ‘j‘ ; ’39)4 |

Layer - Self-fusing tape
or electric tape

* Use knurled’'washers
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DI/DO Diagram

Dry contact with external DC power source to supply a relay. Dry contact is the safest connection
to protect devices.

DI-

DOH]
DI+ Switch
0 L o—‘
Photo

DO-
Coupler

I TP @ External DC power

DCcov

o |

A

External AC power

R bcov with Protected Earth
No | | NC
PE
l Relay
T External Device

Wet contact with external DC power source to supply a relay.

DI-
DO+}
DI+ Switch
[ s o— |
DO-
m
U

pcov
1w @ External DC power

External AC power

— W|th Protected Earth
PE

&

° External Device

-_—

. The DO+ pin provides 12V output voltage, and the max. load is 50mA.

2. The max. voltage for DO- pins is 30VDC (External power).
In order to control AC devices, the above diagram can be taken in consideration. The
diagram uses a relay to control the ON/OFF condition of the AC device.

3. An external relay can be triggered by using DO+ or by an external power source,
depending on the type of relay you use.

4. In case of using an individual relay (instead of using a relay module), for protection

against voltage or current spikes, a transient voltage suppression diode must be

connected in parallel with the inductive load.
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Dry contact and using camera’s DO+ to supply a relay.

DI-
I L
DO+l S
DI+ i
[ o/c Switch
DO-
r
|
1 L
NO

18 - User's Manual
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l Relay
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External Device

External AC power
with Protected Earth
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11. Install the base plate to wall by driving 4 screws.

12. Use the T20 wrench to open the panel cover on the camera.

User's Manual - 19
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13. If preferred, install a MicroSD card to the camera. You can connect a WiFi dongle
to the camera's micro USB port for an onsite adjustment of imaging and the shooting
direction. You can use a notebook to connect the camera at the installation site via a
wireless connection.

¥

i_; 8
MICRO SD

MICRO USB

O
STATUS
[e]

RESET

Micro B
converter

Refer to Step 18 for how to
open a web console.

14. Connect the safety tether wire to the base of the camera.

CONNY
\ CONN2

20 - User's Manual
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15. Connect the Ethernet and the I/O combo cable to the camera.

Ethernet

16. Use the alignment marks on the camera and the base plate to align and secure the
camera by fastening 3 T20 anti-tamper screws.

User's Manual - 21
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17. Install the sun shield to camera. You can move the sun shield back and forth depending
on the relative position at your installation site.

18. Please visit VIVOTEK’s website to Install the "Shepherd” software utility. The program
will search for VIVOTEK Video Receivers, Video Servers or Network Cameras on the

same LAN.

Double-click on the camera’s MAC address to open a web console to the camera.

Shepherd

Yuwor ege-pixe Retwork Camers

22 - User's Manual
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19. Loosen the retention screw on the side of camera bracket in order to adjust the
camera's shooting direction.

20. Remove the protective sheet on the camera lens.
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Installation option A:
A-1. See below for the mounting holes used with applicable conduit boxes.

4" square and round box

Cantex 3/4” type FSE 2 Gang, Outdoor/Indoor electrical box
Generic 3/4” conduit box enclosure, 3/5 holes

A-2. Use the A holes to mount the base plate to a wall.

Using A holes

The 1/2" threaded pipe and hex nut are user-supplied.

24 - User's Manual
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A-3. Drive screws to secure the bracket to wall. When installing camera, secure 4 T20
screws from the base plate.

Wall-mount
using A holes

T20 anti-tamper
M4 x 18

User's Manual - 25
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A-4. Secure the 1/2" conduit pipe using the side-routing bracket. You can then route cables
and install the camera and base plate to the bracket.

Installation option B:
B-1. Pass the I/O extension kit cable through the cabling hole.

CONN 2 12 pin

26 - User's Manual
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B-2. Connect the pin headers to the I/O extension module and that on the camera. Note
the orientation of the pin headers with the positions of the tabs. Properly install the
grommet as previously described.

CONN 2 12 pin

DI-: Green/W DO+(12V): Purple
DI2+: Orange/W

DI3+: Yellow/W

DO2-: Gray

DO3-: Blue/W

User's Manual - 27
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Software Installation

22. Install the Shepherd utility, which helps you locate and configure your Network Camera
in the local network. If your camera comes without the CD, go to VIVOTEK’s website,
and locate the utility in the Downloads > Software page.

%/VIV@I=K Products Support Downloads Solutions L«

—

" Product Files

-
i — Brochure

| Firmware
L — .._.___J ——]

| Flyer

Wall Paper

for Touggm®

22-1. Run the Shepherd utility.

22-2. The program will conduct an analysis of your network environment.

1 3 device(s) found (@

All devices Selected

Model MAC Firmware

AW-GET-094A-..  192.168.4.123 00-02-D1-2F-B7-3C 0106
SD8161 192.168.50.4 00-02-D1-30-55-BF 0100g6
FE9181-H 192.168.50.3 00-02-D1-3E-1D-97 0100b3
179361-EH 192.168.4.148 00-02-D1-43-E6-52 0102f
FD8177-H 192.168.4.147 00-02-D1-4B-F2-1C 0100e_8
SD9366-EHL 192.168.4.105 00-02-D1-4C-FB-EB 0103a
AW-GEU-086A-... 192.168.50.1 00-02-D1-4E-D8-14 0001
VAST 169.254.214.242 00-50-56-C0-00-01 11218
VAST 192.168.4.113 2C-60-0C-FF-52-9F 1.13.03
VAST 192.168.4.131 2C-60-0C-FF-52-A0 1.12.1.8
VAST 192.168.4.121 34-E6-D7-24-7D-C6 1.13.03

VAST 192.168.4.118 54-53-ED-B3-B9-9E 1.13.0.3
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22-3. The program will search for all VIVOTEK network devices on the same LAN.

22-4. After a brief search, the installer window will prompt. Click on the MAC and model
name that matches the one printed on the product label. You can then double-click on
the address to open a management session with the Network Camera.

%VIV@EK 1 selected o
MAC:0002D1730202 RoHSc € -

(TR | S o

e
irmware
9367-EHTV-v2 2.
129361-EH 192.168.4.148 no/ \n1 a2 cc 0102f
0002D1730202
FD8177-H 192.168.4.147 0100e 8
SD9366-EHL 192.168.4.105 00-02-D1-4C-FB-EB 0103a

VAST 169.254.8.13 00-50-56-C0-00-01 11218

VAST 192.168.4.113 2C-60-0C-FF-52-9F 1.13.03

VAST 192.168.4.131 2C-60-0C-FF-52-A0 11218

VAST 192.168.4.118 54-53-ED-B3-B9-9E 1.13.03

VAST 192.168.4.130 54-A0-50-8B-39-3B 11218

1B8360-W 169.254.205.239 5C-F3-70-36-29-D3 0100b

VAST 169.254.182.143 68-05-CA-1F-8D-10 11218
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Forceful Password Configuration

23. The first time you log in to the camera, the firmware will prompt for a password
configuration for security concerns.

23-1. Since your camera is used for the first time, there is no password. Enter “root” as the
user name, and nothting for the password.

The server 169.234 203.239 is asking for your user name and
password. The server reports that it is from streaming_server.

VWarning: Your user name and password will be sent using basic
authentication on a connection that isn’ t secure.

[ root
- [
Remember my credentials

23-2. Enter the combination of alphabetic and numeric characters to fulfill the password
strength. requirement. The default name for the camera administrator is “root”, and can
not be changed.

¥ viversk

wWww.viVveTENx.Som

Language

Configure password

Password should meet the following requirements:
*8~64 characters with no spaces
*include at least one alphabetic character
*include at least one numeric character

User name : root
User password . | LY YYYYYYYY) | Medium
Confirm user password : |”'”'”" |

[[] Enable HTTPS secure connection

*The new password will be applied to all connections

Next Cancel
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Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

You have used invalid characters. These characters are valid:A-Z,
A a-z, -9 and 15%-.@"_~

23-3. Another prompt will request for the password you just configured. Enter the password
and then you can start configure your camera and see the live view.

The server 169.254.205.23% is asking for your user name and
password. The server reports that it is from streaming_server.

Warning: Your user name and password will be sent using basic
authentication on a connection that isn’ tsecure.

oo |

(esecccessceces |
Remember my credentials

(= J[ &= |
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Cybersecurity

Once you open the web console, enter Configuration > Applications > Package
management, and click on Trend Micro loT Security. Turn on the protection to fend off cyber
attacks.

In here, you can let the camera automatically update the virus codes or manually update the
virus codes.

vvvvvvvvvvv =am Home Client settings EelLULINELGTM Language
Applications > Package management

System Package | | License

Media — Upload packag
Select fils
Network © toicad
Security R status
CPU loading: 42 %
PTZ
Internal storage total size: 1951.828 MB Free size: 1803.769 MB
(B Memory total size 1986.105 MB Freesize:  1213.089 MB
Applications
Motion detection - Clean 9
Smart VCA Motice! It will erase system temporary files and the files upload from FTP.
Dl and DO
Tampering detection
Audio detection o F ge list
Shock detection Name Version Status  License size WD
(O Trend Micro loT Security 13ea181 Installed NIA 6246MB N
Package management
Q Deep Learning VCA 6.6.4.0-3e ON N/A 17.030MB Ox 0
Recordi
scording fe] Stratocast 13eals0  ON NiA L066MB Cn 00
Storage
|[_ Schedule

Cybersecurity

Trend Micro loT Security On/off @) (o
Signature update
Current Version: 1.028
Auto Update ()
Manual Update:
Select Signature File : o =
Event Tigger for 3rd party Software
Brute force attack ()
Cyber attack (:)
Quarantine event &
License Expiration event [ @
Attack Block Summary
Since 2020/05/05, block total 0 hits v
@Copyright VIVOTEK. Inc @ TREND,
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24. On a web console, go to Configuration > Media > Image > Focus, to tune for a best
image focus.

Configuration > Media > Image > Focus

Media > Image

Channel:
| General settings | | Image settings ‘ | Exposure ‘ Focus | Privacy mask ‘

(TCP-V

zoom  [e=][ = ] e IE[ES
Focus [s=[< ]y, , , ‘ CIE]

— Auto Focus g —
[JFull-range scan [/ Fully-opened iris

— Focus window
@ Full view

() Custom

25. With a satisfactory field of view, you can tighten the retention screw on the bracket.

T20
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Hardware Reset

The reset button is used to reset the system or restore the factory default settings.
Sometimes resetting the system can return the camera to normal operation. If the system
problems remain after reset, restore the factory settings and install again.

Reset: Press the recessed reset button. Wait for the Network Camera to reboot.

Restore: Press and hold the reset button until the status LED rapidly blinks. Note that all

settings will be restored to factory default. Upon successful restore, the status LED will
blink green and red during normal operation.

SD/SDHC/SDXC Card Capacity

This network camera is compliant with SD/SDHC/SDXC 16GB / 8GB / 32GB / 64GB / ,
and up to 512 / 1024GB and other preceding standard SD cards.
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Network Deployment

General Connection (PoE)

o When using a PoE-enabled switch

The Network Camera is PoE-compliant, allowing transmission of power and data via a sin-
gle Ethernet cable. Follow the below illustration to connect the Network Camera to a PoE-
enabled switch via Ethernet cable.

802.3af PoE Switch

o When using a non-PoE switch

Use a PoE power injector (optional) to connect between the Network Camera and a non-
PoE switch.

PoE Power Injector
(optional)

Non-PoE Switch

4 NOTE:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed |I.T.E. with PoE output.
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Ready to Use

1.A browser session to the Network Camera should prompt as shown below.

2.You should be able to see live video from your camera. You may also install the
32-channel recording software in a deployment consisting of multiple cameras. For its
installation details, please refer to its related documents.

VIVOT=K IB9391-EHTV-v2
Profile name:

T Client settings | Configuration | Language
« Manual triggers:
a 7

Digital output:
PTZ control:

N
=L

=
E

[=] Zoom [+]

[FPan ]
Pan speed:
Tilt speed:
Zoom speed:
Focus speed:
& Global view:

eeeag
< <<

e

SRR

Goto[ - Selectone - |
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Internet connection via a router

Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.

Regarding how to obtain your IP address, please refer to Software Installation on page 20 for
details.

IP address : 192.168.0.3
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

WAN (Wide Area Network )
Router IP address : from ISP,

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

IP address : 192.168.0.2

Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.

Cable or DSL Modem

m HTTP port: default is 80

m RTSP port: default is 554

m RTP port for video: default is 5556
m RTCP port for video: default is 5557

If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 99 for details.

Int | i ith static IP

Choose this connection type if you are required to use a static IP for the Network Camera.

Intern nnection via PPPoE (Point-to-Point over Ethern

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 100 for details.
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For example, your router and IP settings may look like this:

Device IP Address: internal port  |IP Address: External Port (Mapped
port on the router)

Public IP of router 122.146.57.120

LAN IP of router 192.168.2.1
Camera 1 192.168.2.10:80 122.146.57.120:8000
Camera 2 192.168.2.11:80 122.146.57.120:8001

Configure the router, virtual server or firewall, so that the router can forward any data com-
ing into a preconfigured port number to a network camera on the private network, and
allow data from the camera to be transmitted to the outside of the network over the same
path.

From Forward to
122.146.57.120:8000 (192.168.2.10:80
122.146.57.120:8001 {192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP
request as follows: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports
accordingly on your router. For example, you can open a management session with your
router to configure access through the router to the camera within your local network.
Please consult your network administrator for router configuration if you have troubles with
the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic
port forwarding feature as an NAT traversal function with the precondition that your router
must support the UPnP port forwarding feature.

Metwork = General settings

System

Media

& Lay

Hetwork & et P address automaticaly

General seftings i U Bxed P address

Sireamang prolocols [# Enabie UPn presenistion

DONS I [¥] Enable UPSP part farwarding I

QoS & PRPOE

SHMP [# Enable PvE
) The dievice & configunng now, Veur EFowser will reconnect
Security 1BwE informng  fo hHpotIS2 1684, 180:80¢
PTZ ) anouty mmmmhmF

N
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Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

Use Installation Wizard 2 (IW2) to access the Network Cameras on LAN.
If your network environment is not a LAN, follow these steps to access the Netwotk Camera:
1. Launch your web browser (e.g., Microsoft® Internet Explorer or Mozilla Firefox).
2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. Live video will be displayed in your web browser.
4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as

Fle Edt Vew

Q- © MR G|Pms frrmw @252 8

adivess | €] hetpuif152.168.5.151]

BRI
x

ontrof from VIVOTEK INC., Click here to instal. ..

]

Mega-Pixel Network Camera

This is  plug-in (ActiveX). f you see this text, your browser is not support or disable ActiveX.

o[ [u] (] o] (] ] ) (] ] ]

Did you notice the Information Bar?

The Informalion Bar slets you when Inteiet Exploer bocks a
op-up vindow o fle dowrload that might o be safe. I 2

Wb page does ot disply proper, look o the Information
Bt [near the top of your browser)

4
(100 ot show this message again. ‘

leansbouteomaionfx. [0k ]

) Network Camera - Mozilla Firefox
e £k Wew Hgoy Bookmarks Do e

shown below. Follow the instructions to install the required plug-in on your computer.

O - ¢ % @ [Oiwieess

8 Adtonslplugns arerequied to diply althe mediaon tis page.

ol

© oone I I

| ® et

Mega-Pixel Network Camera

Press Next o stal these plgs.

=2

Cancel

» By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on

page 120.
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» If you see a dialog box indicating that your security settings prohibit running ActiveX®
Controls, please enable the ActiveX® Controls for your browser.

1. Choose Tools > Internet Options > Security > Custom Level.

Internet Options

[ General] Security | Frivacy " Content " Connections" Programs" Advanced]

Select a'w'eb content zone to specify itz secunity setiings.

® €@ 0 @

nh—-nn—-r Local intranet  Trusted sites Restricted
sites
Internet
Thiz zone containg all'wWeb zites you S
hawven't placed in other zones Sk

Security level for thiz zone

Custom
Custom settings.
- To change the settings, click Custom Lewel.
- To uge the recommended settings, click Default Level.

JI Default Lewvel J

[ Custom Level...

i Ok I[ Cancel ]| Apply |

2. Look for Download signed ActiveX® controls; select Enable or Prompt. Click OK.

Security Settings

Setkings:

controls and plug-ins
4] Download signed Activer controls

Disable
Enable
@) Prompk

(=

ﬁ Download unsigned Ackiver controls

Disable
Enable
Prompk

In|t|a||ze and script Ackivelr controls not marked as safe
Disable
Enable

Prompt . @J

[T N [ S W
=&

Reset cuskam settings

Reset ta: |Medium L:i|[ Resek J

I Ok i[ Cancel J

3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.
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A IMPORTANT:

Currently the Network Camera utilizes a 32-bit ActiveX plugin. You CAN NOT open a
management/view session to the camera using a 64-bit IE browser.
If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW64. A 32-bit version of IE browser will be installed.
On Windows 7, the 32-bit explorer browser can be accessed from here:

C:\Program Files (x86)\Internet Explorer\iexplore.exe
If you open a web session from the Shepherd utility, a 32-bit IE browser will be
opened.

-‘@'- Tips:

1. The onscreen Java control can malfunction under the following situations: A PC con-
nects to different cameras that are using the same IP address (or the same camera
running different firmware versions). Removing your browser cookies will solve this
problem.

2. If you encounter problems with displaying the configuration menus or Ul items, try dis-
able the Compatibility View on IE8 or IE9.

) JE http://www joinsmsn.com/ D~|2e x

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IE9 mode.

File Find Disable View Images Cache Tools Validaie| IR GG (= Document Mode: [E9 standards =

HTML | CS5 Console Script Profiler Metwork Internet Explorer7 £

L\f [md [ *#+ @ =] Internet Explorer &

- <!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8 °
B <html xmlns="http:// www. /1999 /xhtml"> Internet Explorer 8 Compatibility View

v | Internet Explorer@ =

* In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was
previously installed.

|, Business Explorer

| Camera Stream Contraller
Z# Uninstall

;h Catalyst Control Center

an
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Using RTSP Players

To view the streaming media using RTSP players, you can use one of the following players that
support RTSP streaming.

Q VLC media player

1. Launch the RTSP player.
2. Choose File > Open URL. A URL dialog box will pop up.
3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for

>
r\oStlrl-leuaoan;IuerosglelerD?ayclc only allow RTSP streaming through port number 554, please set the

RTSP port to 554. For more information, please refer to RTSP Streaming on page 107.
For example: AL

A Open Media -
Playlist (") File @) Disc %2 Network [EF Capture Device
= Playlist Network Protocol

Media Librar Please enter a network URL;
My Computer "ot

My Videos

4. The live video will be dlsplayed in your player.

A rtsp://192.168.51.145:554/live1s1.sdp - VLC media player = o
Media Playback Audio Video Subtitle Tools View Help
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Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

35.

To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 42.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video and audio streaming parameters as listed below.
For more information, please refer to Stream settings on page 107.

Video Mode T MPEG-4
Frame size T 176 x 144
Maximum framerate ~~ 5fps
Intra frame period 1S

Video quality (Constant bit rate) ~ 40kbps
Audio type (GSM-AMR) T 12.2kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page107.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., Real Player).

5. Type the following URL commands in the URL field.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream 3>.

For example: A VLCmedia pl A Open Media - - x ) )

Media Playback]
Playlist [ File  ®Diss % Network Capture Device

= Playlist l Network Protocol
Media Library] Please enter a network URL:
My Computer 77 \
[ My Videos
1 My Music
My Pictures
Devices

) Discs

&

j ﬁ [] Show more options e
7. i Pl Cancel
> mm e

You can configure Stream #2 into the suggested stream settings as listed above for live
viewing on a mobile device.
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Using VIVOTEK Recording Software

You can download a VAST recording software, allowing simultaneous monitoring and video
recording for multiple Network Cameras. Please install the recording software; then launch the
program to add the Network Camera to the Channel list. For detailed information about how to
use the recording software, please refer to the user’s manual of the software or download it from
http://www.vivotek.com.

WV vAST

FE8180
1920%1920
H264

1

e
5 "
9:03

A

80
8/18 15:0

-‘@’- Tips:
1. If you encounter problems with displaying live view or the onscreen plug-in control, you may try

to remove the plug-ins that might have been installed on your computer. Remove the following
folder: C:\Program Files (x86)\Camera Stream Controller\.

2. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

3. If DHCP is enabled in your network, and the camera cannot be accessed, run the Shepherd
utility to search the network. If the camera has been configured with fixed IP that does not
comply with your local network, you may see its default IP 169.254.x.x. If you still cannot find
the camera, you can restore the camera to its factory defaults.

4. If you change your network parameters, e.g., added a connection to a LAN card, re-start the
Shepherd utility.


http://www.vivotek.com

VIVOTEK

Main Page

This chapter explains the layout of the main page. It is composed of the following sections:
VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, Menu, and Live
Video Window.

Resize Buttons
VIVOTEK INC.

Logo

VIVOT=K IB9391-EHTV-v2

Host Name )
............. T contgraton | gz Configuration

Area

Live View Window

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name
The host name can be customized to fit your needs. The name can be changed especially there are many
cameras in your surveillance deployment. For more information, please refer to System on page 56.

Camera Control Area

Profile mode: 4 pre-configured streaming profiles are provided through here: Max. view, Recording
view, Live view, and App. Each mode features a different stream source (channel), resolution, multicast,
and metadata configuration.

The profiles can be configured in Configuration > Media > Media profiles.

Manual Trigger: Click to enable/disable an event trigger manually. Please configure an event setting on
the Application page before you enable this function. A total of 3 event configuration can be configured.
For more information about event setting, please refer to page 139. If you want to hide this item on
the homepage, please go to Configuration> System > Homepage Layout > General settings >
Customized button to deselect the “show manual trigger button” checkbox.

User's Manual - 45




VIVOTEK

Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 50.

Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 55.

Language: Click this button to choose a language for the user interface. Language options are available

in: English, Deutsch, Espafriol, Frangais, Italiano, P # 3, Portugués, f§ +* %, and %487 * . Please
note that you can also change a language on the Configuration page; please refer to page 55.

Hide Button
You can click the hide button to hide or display the control panel.

Resize Buttons

EmELNEEREES]

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.

Live Video Window

m The following window is displayed when the video mode is set to H.264 or H.265:
H.265/264 Protocol and Media Options
Video Title  vided (TPC-AV) 2019/03/25 17:08:56 Time
Title and Time | video 17:08:56 2019/03/25

Zoom Indicator

Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 69.

H.264 or H. 265 Protocol and Media Options: The transmission protocol and media options for H.264 or
H.265 video streaming. For further configuration, please refer to Client Settings on page 50.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 69.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > General settings on page 74.
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PTZ Panel: This Network Camera supports “digital® (e-PTZ) pan/tilt/zoom control, which allows roaming
a smaller view frame within a large view frame. Please refer to PTZ settiings on page 135 for detailed
information.

Global View: Click on this item to display the Global View window. The Global View window contains a
full view image (the largest frame size of the captured video) and a floating frame (the viewing region of
the current video stream). The floating frame allows users to control the e-PTZ function (Electronic Pan/
TiltYZoom). For more information about e-PTZ operation, please refer to E-PTZ Operation on page 135.
For more information about how to set up the viewing region of the current video stream, please refer to
page 135.

* Global View: The viewing region of

B ) the curruent video

a T stream

The largest frame size

Maving Instantly

Note that the PTZ buttons on the panel are not operational unless you are showing only a portion of the
full image. If the live view window is displaying the full view, the PTZ buttons are not functional.

Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

@ Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

[C] Disable digital ptz

Zoom Factor:
ALK
- 100% 400%

@ Pause: Pause the transmission of the streaming media. The button becomes the E Resume button
after clicking the Pause button.

E Stop: Stop the transmission of the streaming media. Click the E Resume button to continue
transmission.

E Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the E Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 51 for details.

Volume: When the @ Mute function is not activated, move the slider bar to adjust the volume on the
local computer.



VIVOTEK

Mute: Turn off the volume on the local computer. The button becomes the IZI Audio On button after
clicking the Mute button.

IEI Talk: Click this button to talk to people around the Network Camera. Audio will project from
the external speaker connected to the Network Camera. Click this button . again to end talking
transmission.

m Mic Volume: When the Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.

Mute: Turn off the m Mic volume on the local computer. The button becomes the Mic On button
after clicking the Mute button.

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

ﬁ NOTE:

1. For a megapixel camera, it is recommended to use monitors of the 24" size or larger, and
are capable of 1600x1200 or better resolutions.
2. Below are the defaults for Audio settings:
For cameras with built-in microphone: Not Muted.
For cameras without built-in microphone: Muted.
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m The following window is displayed when the video mode is set to MJPEG:

Video Title Video| (HTTP-V) 2019/01/25 17:08:56
Title and Time | Video 17:08:56 2019/01/25

ol 4

A

@ Se-lo—=Seleet Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Media > Image on
page 74.

Time: Display the current time. For more information, please refer to Media > Image on page 74.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Media > Image on page 74.

Video Control Buttons: Depending on the Network Camera model and Network Camera configuration,
some buttons may not be available.

@ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation

screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen.

Disable digital ptz

Zoom Factor: 100%
L
. 100% 400%

IZI Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the @ Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 51 for details.

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.
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Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.265/H.264 Media Options

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264.

H.265/H.264 Protocol Options

H.265/H.264 protocol options
|7 TCP v

Depending on your network environment, there are four transmission modes of H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP_multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 107.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of the UDP protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users inside a firewall can utilize this protocol to allow
streaming data through.
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Two way audio

Two way audio

@ Half-duplex

) Full-duplex

Half duplex: Audio is transmitted from one direction at a time, e.g., from a PC holding a web console with
the camera.
Full duplex: Audio is transmitted in both directions simultaneously.

MP4 Saving Options

— MP4 saving options

Folder: | C\Record | | Browse...

File name prefix | CLIP |

Add date and fime suffixto file name

Users can record live video as they are watching it by clicking IZ] Start MP4 Recording on the main
page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination on your PC for the recorded video files. The location can be
changed.

File name prefix: Enter the text that will be appended to the front of the video file name. A specified folder
will be automatically created on your local hard disk.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

( )\

CLIP_20190321-180853

tt

File name prefix Date and time suffix
The formatis: YYYYMMDD_HHMMSS

Local Streaming Buffer Time

Eluillisecond

|' Local streaming buffer time

In the case of encountering unsteady bandwidth, live streaming may lag and video streaming may not be
very smoothly. If you enable this option, the live streaming will be stored temporarily on your PC’s cache
memory for a few milli seconds before being played on the live viewing window. This will help you see
the streaming more smoothly. If you enter 3,000 Millisecond, the streaming will delay for 3 seconds.
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Joystick settings

Enable Joystick
Connect a joystick to a USB port on your management computer. Supported by the plug-in
(Microsoft’s DirectX), once the plug-in for the web console is loaded, it will automatically detect if
there is any joystick on the computer. The joystick should work properly without installing any other
driver or software.

Then you can begin to configure the joystick settings of connected devices. Please follow the
instructions below to enable joystick settings.

1. Select a detected joystick, if there are multiple, from the Selected joystick menu. If your joystick
is not detected, if may be defective.

2. Click Calibrate or Configure buttons to configure the joystick-related settings.

Joystick settings

Selected joystick: | [IEESTN:

[ Calibrate | configure buttons |

@ NOTE:

+ If you want to assign Preset actions to your joystick, the preset locations should be configured
in advance in the Configuration > PTZ page. In Windows, use the search function on the Start
menu to search for Game Controller.

« If your joystick is not working properly, it may need to be calibrated. Click the Calibrate button
to open the Game Controllers window located in Microsoft Windows control panel and follow the
instructions for trouble shooting.

* The joystick will appear in the Game Controllers list in the Windows Control panel. If you want to
check out for your devices, go to the following page: Start -> Control Panel -> Game Controllers.

Game Controllers

These zettings help you configure the game contrallers installed on
Your computer.

Inztalled game contrallers

Controller | Status |
CH FRODUCTS IF DESKTOP COMTROLLER

[ Add... ] [ Femaove ] [ Properties ]

[ Advanced... ][ Troublezhoat... J
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Buttons Configuration

In the Button Configuration window, the left column shows the actions you can assign, and the right
column shows the functional buttons and assigned actions. The number of buttons may differ from

different joysticks.

Please follow the steps below to configure your joystick buttons:
1. Choosing one of the actions and click Assign will pop up a dialog. Then you can assign this

action to a button by pressing the joystick button or select it from the drop-down list.
For example: Assign Home (move to home position) to Button 1.

“ Buttons Configuration

Assigned Actions

k3

|f-‘u:ticuns | |Elutt|:|n5 Iﬂuﬁsigned Actions |
l-- Horne ' ﬁj Buttonl
oo In i Hutton
- Zoorm out
- FoCus
[+ Tris
- Pan Press the joystick button to assign to "Home" or
- Stop select the button from the list below,
- Patral
[+ Preset
~Page Up
~Page Down Bttan2
- Record ta AWI Bittons
- Snapshot Auto Marming Buttond
" Buttons
Clear Selected EEEEEQE
Euttons ok | [ cancel |
| |Buttong
Buttonlo oK | | Cancel
Buttonll
Buttonlz2
2. Click OK to confirm the configuration.
“ Buttons Configuration |§|

Aszigned Actions

Press the joystick button to assign to "Horme" or

- Zoom In
- Zoom oot
[+ Focus select the button from the list below,
[+ Iris
~Pan N
- Patrol
= Preset Click "Ok" to assign "" to buttonl
- Preset]
----- Preszetd
----- Presetd
----- Preszet4
[ Assign J I Clear Selected J
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Buttons Configuration

Click the Configure Buttons button, a window will prompt as shown below. Please follow the steps
below to configure your joystick buttons:
1. Select a button number from the Button # pull-down menu.

— : 1
] i | -‘@’- Tips:
>Joystick Settings

If you are not sure of the locations of each
Actions: | Toggle playipause  [~] button, use the Properties window in the Game
Assign | | Controllers utility.
Button: |1 [« Delete
1
Button |3 Assigned Actions e e s s e oy
1 ; Full Screen I ;:f;ﬁmgf help you configure the game cantiollers installed on -
2 G Stop Installed game cortralers ——————————————————————
7 Controller [ Status
3 8 Zoom il"l Macally ArStick aK
4 9 HKhsis /Y Bais Shd.
10 Buttor Point of View Hat
: ol lpa:ml 000006000
oggle play/pause Add. | Remowe | Propeies | oOD®® @
S
Advanced.. Troubleshoot,
a
a o |
10 | oK el | o |
11
12 Snapshot
@ R | BEBOT W %> oo - |

2. Select a corresponding action, such as Patrol or Preset#.

3. Click the Assign button to assign an action to
the button. You can delete an association by
selecting a button number, and then click the
Delete button.

Actions’ | Toggle play/pause
Repeat the process until you are done with the || -

configuration of all preferred actions. Buton: |Snapetot

Full Screen
The buttons you define should appear on the Stantstop recording

Pan
button list accordingly. BUMton | ol
1 Stop
Zoom in
Zaoom out
Digital output on/off 1
Digital output on/off 2
Digital output onfoff 3
Digital output on/off 4
Manual trigger on/off 1
Manual trigger on/off 2
Manual trigger onfoff 3
Preset 1
Preset 2
Preset 3
Preset 4
Preset5
Preset @
Preset7 e
Preset 8
Preset9
Preset 10
Preset 11
Preset 12
Preset 13 =

4. Please remember to click the Save button
on the Client settings page to preserver your
settings.

2= = - TN Y = L -

T
-

"
%]
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Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

VIVOTEK provides an easy-to-use user interface that helps you set up your network camera
with minimal effort. In order to simplify the user interface, detailed information will be hidden
unless you click on the function item. When you click on the first sub-item, the detailed
information for the first sub-item will be displayed; when you click on the second sub-item, the
detailed information for the second sub-item will be displayed and that of the first sub-item will
be hidden.

The following is the interface of the main page:

VIVOT=K

ome Client settings Pl [IEIGLE Language
System > General settings

~ System Navigation Area

General settings Host name: IB9391-EHTV-v2

ACIEE D T () Turn off the LED indicator

Logs

Parameters — System time

Maintenance Time zone:

Media ‘ GMT+08:00 Beijing, Chongqing, Hong Kong, Kuala Lumpur, Singapore, Taipei, Irkutsk 4

(@ Keep current date and time
Network
O Synchronize with computer time

Security (O Manual

PTZ (O Automatic

Event

Applications

Configuration List
Recording

Storage

Version: 1.2201.37 .0%¢ Firmware Version

Each function on the configuration list will be explained in the following sections.

The Navigation Area provides access to all different views from the Home page (for live viewing),
Configuration page, and multi-language selection.
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Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

VIVOTEK offers an easy-to-use user interface that helps you set up your network camera with
minimal effort. To simplify the setting procedure, two types of user interfaces are available:
Advanced Mode for professional users and Basic Mode for entry-level users. Some advanced
functions (PTZ/ Event/ Recording/ Local storage) are not displayed in the Basic Mode.

If you want to set up advanced functions, please click [Advanced Mode] on the bottom of the
configuration list to quickly switch to Advanced Mode.

In order to simplify the user interface, the detailed information will be hidden unless you click on
the function item. When you click on the first sub-item, the detailed information for the first sub-

item will be displayed; when you click on the second sub-item, the detailed information for the
second sub-item will be displayed and that of the first sub-item will be hidden.

The following is the interface of the Basic Mode and the Advanced Mode:

Basic Mode

% viver=k

BRI T L Huomre et Il"ﬂ]l'lu’l Configuration I.anuu:ul

myslam > xenaral satlings
System Masigation Area

i Hamtname: Wepa-Pied Metwark Camera

[ Tum aff the LED ndicator

Caonfiguration List
Sysiaim Hme

0 Kaeg currend diaks and bime
3 Bynchionize with compuier §me
i Manual

= Sutnmahic

| Advarced moda | MTE merver 182 16EL 138

Lipdaiing interval: e hisir [=]

Click to swiich to Advanced Moda

Flmmware Wersion
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System time

— System time

Time zone:

| GMT+08:00 Beijing, Chongging, Hong Kong, Kuala Lumpur, Singapore, Taipei, Irkutsk E
() Keep current date and time

(") Synchronize with computer time

() Manual

(@) Automatic
NTF server: |D00|-l11110lg |
Updating interval One hour

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers. The precondition is that the camera must
have the access to the Internet.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

Time zone : Select the appropriate time zone from the list. You can scroll down on the Time zone menu to
find the Customize option and use the POSIX TZ variables. For example, http://www.gnu.org/software/

libc/manual/html_node/TZ-Variable.html.

Time zone:

| Customize [~

Enable daylight saving time
s me
enca e

Here are some examples for TZ values, including the appropriate Daylight Saving Time and its
dates of applicability. In North American Eastern Standard Time (EST) and Eastern Daylight
Time (EDT), the normal offset from UTC is 5 hours; since this is west of the prime meridian,
the sign is positive. Summer time begins on March’s second Sunday at 2:00am, and ends on
November’s first Sunday at 2:00am. EST+5EDT,M3.2.0/2,M11.1.0/2

Israel Standard Time (IST) and Israel Daylight Time (IDT) are 2 hours ahead of the prime
meridian in winter, springing forward an hour on March’s fourth Thursday (i.e., on the first Friday
on or after March 23), and falling back on October’s last Sunday.

IST-2IDT,M3.4.4,M10.5.0
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Western Argentina Summer Time (WARST) is 3 hours behind the prime meridian all year.
There is a dummy fall-back transition on December 31 at 25:00 daylight saving time (i.e.,
24:00 standard time, equivalent to January 1 at 00:00 standard time), and a simultaneous
spring-forward transition on January 1 at 00:00 standard time, so daylight saving time is in
effect all year and the initial WART is a placeholder.

The format is TZ = local_timezone,date/time,date/time.
Here, date is in the Mm.n.d format, where:

Mm (1-12) for 12 months
n (1-5) 1 for the first week and 5 for the last week in the month
d (0-6) 0 for Sunday and 6 for Saturday

CST6CDT is the name of the time zone

CST is the abbreviation used when DST is off

6 hours is the time difference from GMT

CDT is the abbreviation used when DST is on
,M3 is the third month

.2 is the second occurrence of the day in the month
.0 is Sunday

/2 is the time

,M11 is the eleventh month

.1 is the first occurrence of the day in the month
.0 is Sunday

/2 is the time

The minimum specifier is down to the hour.

58 - User's Manual




VIVOTEK

System > Homepage layout

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

‘ General settings ‘ ‘ Theme options ‘

VIVOT=K FE9180-H-v2

Video stream

# Manual triggers:

. 22l .
ol 2ln](e)[o] a2 K

Powered by VIVOTEK

[[J Hide Powered by VIVOTEK

m Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo graph
Here you can change the logo at the top of your homepage.

— Logo graph

A customized logo (.jpg) can be uploaded for main page. It will be resized to 160x50 pixels to
replace the previous logo.

() Default @ Custom

VIVOT=K FEEEARS
-

Logo link: ‘ http://www.vivotek.com |

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button

If you want to hide the manual trigger buttons on the homepage, please uncheck this item. This item is
selected by default.

Customized button
’7 Show manual trigger button
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Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview field. Click Save to enable the

settings.

| General settings | ‘ Theme options |

VIVOT=K
Font Color ———— Profile name: || v |

Video stream| 1 v

Background Color of the
Control Area——

¥ Manual triggers:

Font Color of the
Configuration Area
Background Color of the ———

FE9180-H-v2

Configuration Area
— Themes ——— — Color
Font color: #121212
[C] |E || Font color of configuration area: #FFFFFF
Font color of video title: #121212
Preset patterns [ -
O |- || Bk color of control area: #EBEBEB
Bk color of configuration area: -
o IEI Bk color of video area: #FFFFFF
O Custom Frame color: #FFFFFF

Font Color of the
Video Title

———Background Color of
the Video Area

—— Frame Color

General settings | Theme options |

VIVOT=K

Video stream 1 -
Digital output [Cn o1
* Manual trigger:

Mega-Pixel Network

Digital output [EXIEES

Manual trigger:

by % viveTsk

I""IIIDEIE[I.BF’JI
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m Follow the steps below to set up the customized homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

— Themes ———— — Color
Font color:
® H Font color of configuration area: #FFFFFF
Color Selector
Font color of video title:
© - Bk color of control area:
- Bk color of configuration area:
- -. Bk color of video area:
Custom _ | o Custom | Frame color:
Pattern

3. The palette window will pop up as shown below.

Red: ICI Red: E
Green: ICI Green: E
Blue: I:I Blue: E
Hue: ICI Hue: E
Saturation: I:I Saturation: IE
Walue: ICI Yalue: 541

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.
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System > Logs

This section explains how to configure the Network Camera to send the system log to a remote
server as backup.

Log server settings

Log server settings

¥l Enable remote log

port: 514

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.

e e

Fle Edit View Manage Help B

4 @ A B [Diplay 00 Defeut <] 30 Days letin evaluation LI
Date Time Priority Hostname  Message

06-27-2011 17:06:57 Usernfo 192.168.4.103 [RTSP SERVERL Stop one session, IP=192.168.4.101

06:27-2011 17:06:57 Userlnfo 192168.4.103  last message repeated 2 time
06:27-2011 17:06:13 Userlnfo 192168.4.103 [RTSP SERVER]: Stast IP-192.168.4.101
0627-2011 17:06:12 192168.4.103 [RTSP SERVER]: sic#: 0. XMLSParser_ReadAll File /var/iun/sessioninfo failed! "M
06-27-2011 17:06:12 192.168.4.103 [RTSP SERVER]: XML ent element at line 6°M

192168.4.103 [RTSP SERVER]: Stop
192.168.4.103 [RTSP SERVERL:
192.168.4.103 [UPNP DEVICEL
192.168.4.103 [DRM Servicel: Starting DRM service.
1921684103 [

06:27-2011 17:06:12
06:27-2011 17:06:12
06:27-2011 17:06:10
06:27-2011 17:06:08
06272011 17:06:07
06-27-2011 17:06:06
06-27-2011 17:06:06
06:27-2011 17:06:05
06:27-2011 17:06:03
06272011 17:06:01
06-27-2011 17:06:00 Daer
06-27-2011 17:06:00 Daer

I Ready to watch hitpd.
e 192168.4.103 ug s 192.168.0.10 192.168.0.20
e 192168.4.103 uc ter 192.168.4.1
e 192168.4.103 udhcpe: IP 192.168.4.103
192168.4.103 [EVENT MGRI: the process
e 192168.4.103 udhcpe: router 192.16¢
e 192168.4.103 udhcpo: IP 192.168.4.103 netmask 255.255.255.0
e 192.168.4.103 udhepe: deconfig

ask 255.255.255.0
ent #1 is skipped because of low priority 0

System log

J System log ‘ ‘ Access log

Jan 5 11:36:07 syslogd 1.5.0: restart. —
Jan 5 11:36:08 [swatchdog]: Ready to watch httpd.

Jan 5 11:36:09 [EVENT MGR]: Starting eventmgr with support for EcTun

Jan 5 11:36:11 [DRM Service]: Starting DRM service.

Jan 5 11:36:20 [UPnPIGDCP]: Search IGD failed

Jan 5 11:36:23 automount[718]: >> mount: mounting /dev/mmcblkOp1 on /mnt/auto/CF failed: No such
device or address

Jan 5 11:36:23 automount[718]: mount(generic): failed to mount /dev/mmcblkOp1 (type viat)

on /mnt/auto/CF

Jan 5 11:36:23 [IR Cut Control]: Day mode

Jan 5 11:36:23 automount[728]: >> mount: mounting /dev/mmcblkOp1 on /mnt/auto/CF failed: No such
device or address L
Jan 5 11:36:23 automount[728]: mount(generic): failed to mount /dev/mmcblkOp1 (type viat)

on /mnt/auto/CF

Jan § 11:36:23 [IR Cut Control]: Day mode

Jan 5 11:36:23 [SYS]: Serial number = 0002D10ED4C9

Jan 5 11:36:23 [SYS]: System starts at Wed Jan 5 11:36:23 UTC 2011

This column displays the system log in a chronological order. The system log is stored in the Network
Camera’s buffer area and will be overwritten when reaching a certain limit.
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You can install the included VAST recording software, which provides an Event
Management function group for delivering event messages via emails, GSM short
messages, onscreen event panel, or to trigger an alarm, etc. For more information, refer to

the VAST User Manual.

VIVOTEK Network Cameras

I

3G Cell phone

Q
@
Cell phone GSM Server with \ Email
Short message Modem

VAST Recording Software .
ﬁ FTP
» B
|

Deterrent Digital output

PTZ
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Access log

Systemlog | Accesslog | Set parameteriog |VADPlog |

Jan 5 11:36:28 [RTSP SERVER]: Start one session, IP=172.16.2.52
Jan 5 11:49:15 [RTSP SERVER]: Start one session, IP=192.168.4.105
Jan 5 13:11:20 [RTSP SERVER]: Start one session, IP=192.168.4.105

Access log displays the access time and IP address of all viewers (including operators and

administrators) in a chronological order. The access log is stored in the Network Camera’s buffer

area and will be overwritten when reaching a certain limit.

Set Parameter log

VADP log contains the history of changes made to system parameters such as recording, imaging

parameters, and all other parameters.

VADP log

VADP log contains the information for the onboard VADP packages, including memory usage, module

load and unload information.

Sysmlngl[mmg”samnmnng][unmm|

Jan 14 20:22:30 MADP]: Jan 14 20:22:30 [VADP]: File system disk space usage Jan 14 20:22:30
MWADP): Filesystem Size  Used Available Use% Mounted on Jan 14 20:22:30 [WADPT:
Lbi1:flashfs2 323M 0 42M 0 26.4M 14% mntflash2 Jan 14 20:22:20 MADP]:

Jan 14 20:22:30 [WADP]:  Start to upgrade preload package
Jam 14 2002230 [WADP], s Jan 14 2002230 WADP]: Preload
package Size: 3.2M Jan 14 20:22:32 [WADPL: Untar package Size: 6.9M Jan 14 20022:32 MMADPI:
Trend Micro loT Security Preload Package Version: 1.1b.a1.7.5 Jan 14 20:22:41 [VADP]: Update
configuration... Jan 14 2002242 WADP]: Jan 14 20:22:42 NADP]: Trend Micro loT Security is
stopped Jan 14 20:22:43 [WADF]: File system disk space usage Jan 14 20:22:43 WADP]: Upgrade

Filesystem Size  Used Available Use Mounted on Jan 14 20:22:43 [VADP]: Before
ubi1-flashis2 323 1AM 28.5M 3% /mntflash2 Jan 14 20:22:43 [VADP): After
ubi1-flashis2 323 6.0M  24.6M 20% /mntflash2 Jan 14 20:22:43 [WADP]: File space

usage: Jan 14 20:22:43 WADP]: Upgrade 3Size PathJan 14 202243 MMADP]: Before 0Jan 14
20:22:43 [WVADP] After  6.9M  /mntflash2/vadpi0 Jan 14 20:22:43 VADP]: Upgrade preload
Trend Micro loT Security package successfully Jan 14 20:22:43 WADP]. Jan 14 20:22:43 WADPT:
Freload package Size: 1.0M Jan 14 20022:43 [WADP]: Untar package Size: 2.3M Jan 14 20:22:44
MWADP): Stratocast Preload Package Version: 1.1b.a1.4.2 Jan 14 20:22:50 WADP): Update
configuration... Jan 14 20:22:57 WADP]: Jan 14 20:22:57 WADP]: File system disk space usage

Jan 14 20:22:53 WADP]: Upgrade Filesystem Size  Used Available Use% Mounted on
Jan 14 20:22:53 [WADP]: Before ubii:flashfs2 323 50M 25.6M 16% /mntflashz2
Jan 14 20:22:53 MMADP]: After  ubil:flashfs2 323 6.5M 240M 21% /mntflashz Jan

14 20:22:58 MADP]: File space usage: Jan 14 20:22:58 MADP]: Upgrade Size Path Jan 14
20:22:58 [VADP]: Before 0Jan 14 20:22:58 [VADP]: After  2.3M  /mntMash2ivadp/ Jan 14
20:22:58 [WADP]: Upgrade preload Stratocast package successfully Jan 14 20:22:58 [WVADF]: Jan
14 20:22:58 [WADP]; ossmsmmms et saeseses Jan 14 20022:58 [VADP].  Upgrade
preload package end Jan 14 20:22:53 [WADP], srsemsmesmmssidasissimarsssr= Jan 14
20:22:58 [WVADPY]: File system disk space usage Jan 14 20:22:53 [WADP]: Filesystem Size
Used Available Use% Mounted on Jan 14 20:22:58 MNMADPT ubit flashfs2 323M B.5M

[y

W
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System > Parameters

The View Parameters page lists the entire system’s parameters. If you need technical

assistance, please provide the information listed on this page.

— Parameters

system_hostname="IB9391-EHTV-v2'
system_ledoff="@'

system_lowlight="1"

system_date="'26006/01/081"'
system_time='10:14:38"'

system_datetime=""

system_ntp=""

system_daylight_enable="®"
system_daylight_auto_begintime="Not Support’
system_daylight_auto_endtime='Not Support'
system_daylight_timezones=',-360,-320,-280,-240,-241,-200,-140,-121,-40,
e,40,41,80,82,83,140,380,480"
system_updateinterval="0"
system_info_modelname="IB9391-EHTV-v2"
system_info_extendedmodelname="IB9391-EHTV-v2'
system_info_serialnumber="0©2242D3E5EEF'
system_info_firmwareversion="IB9391 v2-VVTK-1.2201.37.01f"
system_info_language_count='10"
system_info_language_ie='English'
system_info_language_il='Deutsch’
system_info_language_i2="'Espanol’
system_info_language_i3='Frangais’
system_info_language_id='Italiano’
system_info_language_i5='H7:E"
system_info_language_i6="'Portugués'
system_info_language i7='E{FEDhIT"
system_info_language i8='ZjEh 7’
system_info_language_i9='Pycckuit'
system_info_language_il0=""
system_info_language_ill=""

. L L
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System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, etc.

General settings > Upgrade firmware

Upgrade firmware

Select firmware file: Browse... [ Upgrade ]

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.

2. Click Browse... and locate the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.
( A
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will take about 1 - 5 minutes.
Wrong PKG file format
Unpack fail
& J

General settings > Reboot

Reboot
{

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to http:/1192 168.5.151:80/

Ifthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.

66 - User's Manual




VIVOTEK

General settings > Restore
— Restore

Restore all seflings to factory default except setiings in

[ ] Network [ | Daylightsaving time [ ] Custom language [ | WVADP [ | Focus position

| Restore ‘

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
100).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

Custom Language: Select this option to retain the Custom Language settings.
VADP: Retain the VADP modules (3rd-party software stored on the SD card) and related settings.
Focus position: Retain the lens focus position using the previously saved position parameters.

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to http:/1192.168.5.151.80/
Ifthe connection fails, please manually enter the above IP address in your browser.

Import/Export files

This feature allows you to Export / Update daylight saving time rules, custom language file, configuration
file, and server status report.

General settings | | Import/Export files ‘

— Export files
Export languaqge file
Export configuration file
Export server status report
— Upload files
Update custom language file:
Upload configuration file:

Export daylight saving time configuration file: Click to set the start and end time of DST (Daylight Saving).

Follow the steps below to export:

1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.

2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.
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The following message is displayed when attempting to upload an incorrect file format.

Microsoft Internet Exploren

:" } The file must hawve a .xml filename suffix,

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Espafiol, Frangais, Italiano, P # 3, Portugués, BRI, and £ ° < .

Update custom language file: Click Browse... and specify your own custom language file to upload.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Update configuration file: Click Browse... to update a configuration file. Please note that the model and
firmware version of the device should be the same as the configuration file. If you have set up a fixed IP
or other special settings for your device, it is not suggested to update a configuration file.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message ... and so
on.

-‘@'— Tips:

+ If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort
method to restore normal operation. See the following for how to bring the camera back to work:

Applicable scenario:

(a) Power disconnected during firmware upgrade.
(b) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working
condition.

You can use the following methods to activate the camera with its backup firmware:

(a) Press and hold down the reset button for at least one minute.

(b) Power on the camera until the Red LED blinks rapidly.

(c) After boot up, the firmware should return to the previous version before the camera hanged. (The
procedure should take 5 to 10 minutes, longer than the normal boot-up process). When this
process is completed, the LED status should return to normal.
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This section explains how to configure the image settings of the Network Camera. It is
composed of the following columns: General settings, IR control, Image settings, Exposure,
Focus, and Privacy mask. The Focus window is available only for models that come with
motorized lens.

General settings General settings | llluminators | Image settings = Exposure | Focus | Privacy mask @ Pixel
calculator
Video settings
Video title

() Show timestamp and video title in video and snapshots

Position of timestamp and video title on image: Top v
Timestamp and video title font-size: 30 v
Video font (.tif): Default v
Color: (O B/W @) Color
Power line frequency: ()50 Hz @60Hz
Video orientation: () Flip (O] Mirror
(] Rotate

Video title

Show_timestamp_and video_title_in_video_and_snapshots: Enter a name that will be displayed on
the title bar of the live video as the picture shown below. A zoom indicator will be displayed on the
Home page when you zoom in/out on the live viewing window as shown below. You may zoom in/
out on the image by scrolling the mouse wheel inside the live viewing window, and the maximum
zoom in will be up to 12 times.

Video Title VidegTCP-Av) 2018/7/09 17:08:56
Title and Time

Zoom Factor

B w—ﬂ f
al2n][e]le](w )

Position of timestamp and video title on image: Select to display time stamp and video title on the
top or at the bottom of the video stream.

Timestamp and video title font size: Select the font size for the time stamp and title.

Video font (.ttf): You can select a True Type font file for the display of textual messages on video.

Mount type: There are 3 Mount types - Ceiling, Wall, and Floor. Selecting the correct mount type
enables the camera image to display the correct video orientation.

Color: Select to display color or black/white video streams.

Power line frequency: Set the power line frequency consistent with local utility settings to eliminate
image flickering associated with fluorescent lights. Note that after the power line frequency is
changed, you must disconnect and reconnect the power cord of the Network Camera in order for
the new setting to take effect.
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Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the
display of the live video. Select both options if the Network Camera is installed upside-down (e.g.,
on the ceiling) to correct the image orientation. Please note that if you have preset locations, those
locations will be cleared after flip/mirror setting.

Rotate -

Mirror Rotate 90°
m) clockwise

E

.........

([v|iRotate  gp [+ Degrees

.........

The rotation here indicates clockwise
rotation. Rotation can be applied with

flip, mirror, and physical lens rotation /\Ek L]
(see below) settings to adapt to different
mounting locations. [] \/{

The figures in the illustration are shown in
a consecutive order.

PN =

=

The camera may be installed on a vertical, side-facing, or tilted surface in order to accommodate
the interior or exterior design of a building. The interior of a building can be shaped as a narrow
rectangular space, such as a corridor. The conventional HD image, such as that of a 16:9 aspect
ratio, will be incongruous with its wide horizontal view. With video rotation, the camera can more
readily cover the field of view on a tall and narrow scene.

Day/Night Settings

— Day/Night settings

[v] switch to BAV in night mede

IR cut filter [#uto mode
Light sensor sensifivity: INonTlaI .

Switch to B/W in night mode
Select this to enable the Network Camera to automatically switch to Black/White during night
mode.
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IR cut filter
With a removable IR-cut filter, this Network Camera can automatically remove the filter to let
Infrared light pass into the sensor during low light conditions.

m Auto mode (The Day/Night Exposure Profile will not be available if Auto mode is selected)
The Network Camera automatically removes the filter by judging the level of ambient light.

m Day mode
In day mode, the Network Camera switches on the IR cut filter at all times to block infrared light
from reaching the sensor so that the colors will not be distorted.

m Night mode
In night mode, the Network Camera switches off the IR cut filter at all times for the sensor to
accept infrared light, thus helping to improve low light sensitivity.

m Synchronize with digital input
If an external IR device is connected that comes with its own light sensor, you can use a digital
input from it to trigger the IR cut filter. Doing so can synchronize the detection of light level
between the camera and the external IR device.

m Schedule mode
The Network Camera switches between day mode and night mode based on a specified
schedule. Enter the start and end time for day mode. Note that the time format is [hh:mm] and is
expressed in 24-hour clock time. By default, the start and end time of day mode are set to 07:00
and 18:00.

Light sensor sensitivity
Tune the responsiveness of the IR filter to lighting conditions as Low, Normal, or High.

When completed with the settings on this page, click Save to enable the settings.
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Turn on built-in IR illuminator in night mode
Select this to turn on the camera’s onboard IR illuminator when the camera detects low light
condition and enters the night mode.

Turn on external IR illuminator in night mode
Select this to turn on the external IR illuminator when the camera detects low light condition and
enters the night mode. A Digital Output connection to external IR is needed. _

Select the digital output from below, Digital output 1 or Digital output 2.

Anti-overexposure: When enabled, the camera automatically adjusts the IR projection to adjacent
objects in order to avoid over-exposure in the night mode.

The Smart IR function is more beneficial when the spot of intrusions or an object of your interest
is close to the lens and the IR lights. For example, if an intruder has a chance of getting near the
range of 3 meters, Smart IR can effectively reduce the over-exposure. For a surveillance area at a
greater distance, e.g., 5 meters or farther away, the Smart IR function may not bring as significant
benefits as in close range.

Smart IR disabled; distance: 5M Smart IR enabled; distance: 5M

Smart IR disabled; distance: 3M Smart IR enabled; distance: 3M
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-‘@'— Tips:

If there is an object in close proximity, the IR lights
reflected back from it can mislead the Smart IR’s
calculation of light level. To solve this problem, you
can place an “Exposure Exclude” window on an
unavoidable object in the Exposure setting window.
See page 72 for how to do it.

You can also configure the “Exposure Exclude”
window in a night mode “Profile” setting so that your
day time setting is not affected.

=Profile of exposure settings

[Ammmmw][m window

— Activated period

{[#]} Enable and appty this profie to

v pply this p Exclude
© Daymode P
@ Night mode e

© Schedule mode

~ Measurement window

© Full view

@ Custom

© BLC

The Smart IR Object of interest is coordinated with the Smart VCA configuration. Configure the
Smart VCA and then select this function.

— Smart IR 4

Target Zone
@ Bright object
Object of interest

Darkest Brightest

Strength: LS

Note! Object of interest can run on firmware with Smart VCA 7.1(or higher).Please turn on
the Smart VCA and set up camera installation before using this function.

Restore l [ Save ]

User's Manual - 73




VIVOTEK

Image settings
On this page, you can tune the White balance and Image adjustment.

calculator

Sensor Setting 2:

For special situations phioma: ] [Frenis mode
White balance -
Aut v
Sensor Setting 1: mage acjustment
For normal situations i s0%

50%

50%

(O Ol O

50%

Gamma curve: Optimize v

White balance: Adjust the value for the best color temperature.
m You may follow the steps below to adjust the white balance to the best color temperature.

1. Place a sheet of paper of white or cooler-color temperature color, such as blue, in front of the
lens, then allow the Network Camera to automatically adjust the color temperature.

2. Click the On button to Fix current value and confirm the setting while the white balance is being
measured.

m You may also manually tune the color temperature by pulling the RGain and BGain slide bars.

Image Adjustment
m Brightness: Adjust the image brightness level, which ranges from 0% to 100%.

m Contrast: Adjust the image contrast level, which ranges from 0% to 100%.

m Saturation: Adjust the image saturation level, which ranges from 0% to 100%.

m Sharpness: Adjust the image sharpness level, which ranges from 0% to 100%.

m Gamma curve: Adjust the image sharpness level, which ranges from 0.45 to 1, from Detailed to
Contrast. You may let firmware Optimize your display or select the Manual mode, and pull the
slide bar pointer to change the preferred level of Gamma correction towards higher contrast or
towards the higher luminance for detailed expression for both dark and lighted areas of an image.

This option is disabled when the WDR feature is enabled.

Defog: Defog helps improve the visibility quality of captured image in poor weather conditions such
as smog, fog, or smoke.
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Hightlight mask: If there are strong light sources in the scene, the system will block out the strong
light sources, and eliminate the effects from the lighting sources. For example, a strong lighting
source can mislead the system to consider the whole scene is well lit, while the other areas is in
fact poorly represented.

Noise reduction

m Enable noise reduction: Check to enable noise reduction in order to reduce noises and flickers
in image. This applies to the onboard 3D Noise Reduction feature. Use the slide bar to adjust
the reduction strength. Note that applying this function to the video channel will consume system
computing power.

3D Noise Reduction is mostly applied in low-light conditions. When enabled in a low-light
condition with fast moving objects, trails of after-images may occur. You may then select a lower
strength level or disable the function.

Lens distortion correction
m Then Lens Distortion Correction is implemented by warping the distorted image input into a
rectified, undistorted image output.

LDC- OFF LDC-ON (Wide angle Mode) | LDC-ON (Non-distortion mode)

Ficld Try

Distortion -43% -10% -10%

Enable digital image stabilizer

If you experience problems such as vibration occurs when on a pole mount, try enable the image
stabilizer.

Scene mode: deblur

m When enabled, shutter time will be fixed to 1/120 second to reduce image smear. This feature

is designed to apply with human movement at the pace of 1.4~2.2m/s. The deblur function
is related to Motion detection where motion-alerted pixels need to be suppressed in order to
increase the accuracy of motion detection. In certain conditions, shadows or light changes can
all cause false alarms in motion detection.

The deblur function uses the same detection window as that of the Motion detection.

User's Manual - 75




VIVOTEK

Note that the Preview button has been cancelled, all changes made to image settings is directly
shown on screen. You can click Restore to recall the original settings without incorporating the
changes. When completed with the settings on this page, click Save to enable the setting. You
can also click on Profile mode to adjust all settings above in a tabbed window for special lighting
conditions.

Normal light mode ‘ | Profile mode

Enable to apply these setings at ~

® MNightmode (O Schedule mode I

Enable to apply these settings at: Select the mode this profile to apply to: Day mode, Night mode,
or Schedule mode. Please manually enter a range of time if you choose the Schedule mode. Then
check Save to take effect.
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Exposure

On this page, you can set the Exposure measurement window, Exposure level, Exposure mode,
Exposure time, Gain control, and Day/Night mode settings. You can configure two sets of Exposure
settings: one for normal situations, the other for special situations, such as the day/night/schedule
mode.

‘ General settings | | llluminators ‘ ‘ Image settings | ‘ Exposure ‘ | Focus ‘ ‘ Privacy mask ‘ ‘m

calculator ‘

Sensor Setting 2:
For special situations = tightmodo Profile mode

Iris made: OUéOOf v -

— AE speed adjustment

(] Enable AE speed adjustment

— WDR

Sensor Setting 1:
For normal situations Enable WDR Pro

Enable WDR enhanced

Low High
Strength: U

4

Restore ] l Save

Exposure strateqy:

Measurement window: This function allows users to set measurement window(s) for low light

compensation. For example, where low-light objects are posed against an extremely bright
background. You may want to exclude the bright sunlight shining through a building's corridor.

m Full view: Calculate the full range of view and offer appropriate light compensation.

m Custom: This option allows you to manually add customized windows as inclusive or exclusive
regions. A total of 10 windows can be configured. Please refer to the next page for detailed
illustration.
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The inclusive window refers to the “weighted window*; the exclusive window refers to “ignored
window®. It adopts the weighted averages method to calculate the value. The inclusive windows
have a higher priority. You can overlap these windows, and, if you place an exclusive window
within a larger inclusive window, the exclusive part of the overlapped windows will be deducted
from the inclusive window. An exposure value will then be calculated out of the remaining of the
inclusive window.

Include X i i
Include X Weighted region

Exclude X

Ignored region

Exclude X

[ Add inclusive window | [ Add exclusive window

L window

© Fullview @ Custom () BLC

m Auto: Firmware automatically determines an optimal exposure level.

m BLC (Back Light Compensation): This option will automatically add a “weighted region® in the
middle of the window and give the necessary light compensation.

m HLC: (Highlight Compensation). Firmware detects strong light sources and compensates on
affected spots to enhance the overall image quality. For example, the HLC helps reduce the
glares produced by spotlights or headlights.
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m Exposure level: You can manually set the Exposure level, which ranges from -2.0 to +2.0 (dark
to bright). You can click and drag the semi-circular pointers on the Exposure time and Gain
control slide bars to specify a range of shutter time and Gain control values within which the
camera can automatically tune to an optimal imaging result. You may prefer a shorter shutter
time to better capture moving objects, while a faster shutter reduces light and needs to be
compensated by electrical brightness gains.

m Exposure mode: (available when WDR Pro is disabled)
You can click and drag the semi-circular pointers on the Exposure time and Gain control slide
bars to specify a range of shutter time and Gain control values within which the camera can
automaticallly tune to an optimal imaging result. You can also configure the iris size to control
the amount of light. For example, you may prefer a shorter shutter time to better capture moving
objects, while a faster shutter reduces light and needs to be compensated by electrical brightness
gains.

m Flickerless: Under some circumstances when there is a difference between the video capture
frequency and local AC power frequency (NTSC or PAL), the mismatch causes color shifts or
flickering images. If the above mismatch occurs, select the Flickerless checkbox, and the range
of Exposure time (the shutter time) will be limited to a range in order to match the AC power
frequency. When selected, the exposure time will be forced to stay longer than 1/120 second.
For cameras that come with fixed iris lens, setting the exposure time to longer than 1/120 second
may introduce too much lights to the lens. Users can use this option to observe whether the
result of long exposure time is satisfactory.

Auto: If you set Exposure mode as Auto, the Exposure time and Gain control will not be
configurable since the sensor library will automatically adjust the value according to the ambient
light. Then you can configure iris mode as “indoor” or “outdoor” to reach the best image quality.

m Iris mode: Select Indoor or Outdoor iris mode to adapt to the installation. The preset iris aperture
setting will apply.

m AE Speed Adjustment:

This function applies when you need to monitor fast changing lighting conditions. For example,
the camera may need to monitor a highway lane or entrance of a parking area at night where
cars passing by with their lights on can bring fast changes in light levels. The same applies if
the camera is installed on a vehicle, and when it needs to adapt to fast changes of light when
entering and leaving a tunnel.

m WDR Pro:

This refers to the Wide Dynamic Range function that enables the camera to capture details in
a high contrast environment. Use the checkbox to enable the function, and use the slide bar
to select the strength of the WDR Pro functionality, depending on the lighting condition at the
installation site. You can select a higher effect when the contrast is high (between the shaded
area and the light behind the objects).

Enable WDR enhanced: This function allows users to identify more image details with an extreme
contrast from an object of interest with one shadowed side against a bright background, e.g., an
entrance. You may select the Enable WDR enhanced checkbox, and then adjust the strength (low,
medium, high) to reach the best image quality.
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You can click Restore to recall the original settings without incorporating the changes. When
completed with the settings on this page, click Save to enable the settings.

If you want to configure another sensor setting for day/night/schedule mode, please click Profile to
open the Profile of exposure settings page as shown below.

Activated period: Select the mode this profile to apply to: Day mode, Night mode, or Schedule
mode. Please manually enter a range of time if you choose Schedule mode. Then check Save to
take effect.

[Geners settings | [ihuminators | [mege settings || Exposirs | Fouus | [ Privacy mesk] [ Poei

Please follow the steps below to set up a profile: L

1. Select the Profile mode tab.

2. Select the applicable mode: Night mode or
Schedule mode. Please manually enter a range of
time if you choose the Schedule mode.

3. Configure Exposure control settings in the folowing
columns. Please refer to previous dicussions for
detailed information.

4. Click Save to enable the setting and click Close to
exit the page.

Vi 7 Sl ¢
Normal light mode  Profile model

() Enable to apply these settings at

— strategy

Measurement window: ~ @ Full view (O Custom O Center

Metering mode: @Auto OBLe QHLe

- control

Exposure level: 0 v

Exposure mode: Auto v

Iris mode: Outdoor v

Restore ] [ Save
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Focus

Focus here refers to the Remote Focus, applicable to Network Cameras that are equipped
with a stepping motor lens. The automated focus adjustment function eliminates the needs
to physically adjust camera focus. In an outdoor deployment consisting of a large number
of cameras, the auto focus function can be very helpful when these cameras become out
of focus after days or weeks of operation. And that can easily result from the effects of
natural forces, e.g., shrink and expand due to a wide range of operating temperatures and
the vibration caused by wind.

| ing: ‘ ‘ Mumi ‘ ‘ Image settings ‘ ‘ Exposure ‘ ‘ Focus | ‘ Privacy mask | ‘ﬁ

calculator ‘

Y, U TR (

Zoom x————
5 [ [ Y = =

— Auto Focus

() Full-range scan Fully-opened iris | Perform auto focus

— Focus window
@ Full view

(O Custom

Below is the procedure to perform the automated Focus function:

1. Select from the bottom of the screen whether you want to perform focus adjustment on
the Full view or within a Custom focus window. You can create a custom window and
click and drag the window to a desired position on screen.

2. It is recommended to Reset to the default back focus position of the sensor board.

3. You can use the Fully-opened iris checkbox (default) to increase the iris size for a
better focus adjustment result.

4. Click to select the Fully-opened iris or the Full-range scan buttons. When a full-range

scan is selected, a full-range scan through the camera's entire focal length can take
about 30 to 80 seconds. If not, the auto focus scan will only go through the length where
optimal focus may occur, and that takes about 15 to 20 seconds. In theory, best results
of the auto scan can be acquired when the camera's iris is fully open.
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5. Wait for the scan to complete. After a short while, the clearest image obtained should be
displayed and the optimal focus range achieved. Use the arrow marks on the sides to fine-tune
the focus if you are not satisfied with the results. You may still need to use the arrow marks to
fine-tune the focus depending on the live image on your screen. “>” means moving from wide to
tele end; and “<” tele to wide.

The methodology of using the Resize Buttons at the upper left corner of the streaming window is
the same as that on the home page.

Focus window:

By default, the optimal focus is found on a full view window. You may designate a custom window
within your current field of view to acquire the best focus out of it. However, you can not place a
focus window on a distant background, e.g., a hall way that stretches away for 3 meters or farther.
Doing so you will not benefit from the Focus window function.

m Full view: The focus tuning takes place by referring to the full view.

m Custom: You can create a focus window and drag it to a place of interest in your view window.
Note that it is recommended to use this function only when you have a solid object in your view
window that is showing a consistent color or texture. This function will not take effect if you set
the focus window on a distant background.
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Privacy mask

Click Privacy Mask to open the settings page. On this page, you can block out sensitive zones to
address privacy concerns.

[Gene ngs} [ Illuminators] { Image seumgs} { Exposure ] { Focus} { Privacy mask } [ﬁ

calcull

Enable privacy mask

Window name

areahA

X
areaB x

| New @Sm |

m To configure privacy mask windows,

1. Click New to add a new window.

2. You can use 4 mouse clicks to create a new masking window, which is recommended to be at
least twice the size of the object (height and width) you want to cover.

3. Enter a Window Name and click Save to enable the setting.

4. Click on the Enable privacy mask checkbox to enable this function.

{J) NOTE:

» Up to 5 privacy mask windows can be configured on the same screen.

» If you want to delete the privacy mask window, please click the x’ mark on the side of window
name.
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Pixel Calculator

Click the Add button at the lower screen to create a pixel calculator window. Place your cursor on
the window to move it to an area of your interest, and change the size of window to fit the area of
interest.

Once they are drawn, the numbers of pixels on the sides of windows will appear. This allows you to
calculate if your current configuration fulfills a requirement, for instance, for recognizing the faces
of persons passing through a location. A facial recognition usually requires around 130 pixels per

meter or higher. The pixels thus calculated are listed

at the lower screen on a per-stream
basis depending on the frame size you
configured for each video stream.

General settings | | llluminators | Image settings Exposure Focus @ Privacy mask Pixel

calculator

=] E= 0%

Pixel Counter
Window1 (H)x{V) Window2 (H)x{V)

Stream1: 551x373 Stream1: 555x370
Streamz2: 55x37 Streamz: 55x37

Stream3: 551x373 Stream3: S55x370



Take the following into consideration when using this feature:
1. Operational requirement: Identify a human or a human face.

2. Why human face? There are less variances in the size of a face than that for limbs and body.
Human face is normally 16cm wide.
3. The recommended pixel number is, 40 to 80 for facial identification; or 100 pixels per foot
(30.48cm)
3-1. One example is a human face in retail.
3-2. Another example is a doorway:
If the requirement is 100 pixels per foot, to detect a person passing through a door, the
camera will have to cover 700 pixels throughout the length of a doorway. This application aims
to identify a subject passing through a specific area.

4. Other factors may include that a person will move in your area of interest: The face may not
always face the camera.

5. Details can be affected by weak lighting or the view angle. Therefore, higher the pixels, higher
the chance you can identify the subject.

6. The pixel calculator visual tool looks like the following.

General settings | llluminators | Image settings  Exposure | Focus | Privacy mask @ Pixel

calculator

IEEEP:-]'D':.I
TP

Pixel Calculator
FIKE Lo
Window1 (H}x(V) Window2 (H)x(V)
Stream1: 551x373 Stream1: 555x370
Streamz: 55x37 Streamz: 55x37

Stream3: 551x373 Stream3: 555x370

With the visual tool, you can estimate a coverage area, the distance from the subject, and place
a ruler or an object of known size. You can then draw a calculator frame to cover the subject of
your interest.

The calculated numbers will be listed at the lower screen. You will then understand if the current
setting fulfills your requests for the number of pixels.
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Media > Video

Stream settings

- Stream

% Video settings for stream 1

¥ Video settings for stream 2

# Video seftings for stream 3 Viewing Window

This Network Camera supports multiple streams with frame sizes ranging from 640 x 360 to 1920 x
1080 pixels

The definition of multiple streams (IB9391):

m Stream 1: The default frame size for Stream 2 is set to the 3840 x 2160.

m Stream 2: The default frame size for Stream 2 is set to the 3840 x 2160.

m Stream 3: The default frame size for Stream 3 is set to the 1280 x 720. Users can define the
"Region of Interest" (viewing region) and the "Output Frame Size" (size of the live view window).

Click Viewing Window to open the viewing region settings page. On this page, you can configure
the Region of Interest and the Output Frame Size for a video stream. For example, you can crop
only a portion of the image that is of your interest, and thus save the bandwidth needed to transmit
the video stream. As shown below, the area of your interest in a parking lot should be the vehicles.
The blue sky is of little value for the surveillance purpose.
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Stream ‘ 'Viewing Window ‘

Video stream :

&
; /

Region of interest : | (0,8) 2240x1256 custom v Save Close

Note: Frame size will be changed to match region of interest.

Please follow the steps below to set up those settings for a stream:

1. Select a stream for which you want to set up the viewing region.

2. Select a Region of Interest from the drop-down list. The floating frame, the same as the one
in the Gloabl View window on the home page, will resize accordingly. If you want to set up
a customized viewing region, you can also resize and drag the floating frame to a desired
position with your mouse.

3. Choose a proper Output Frame Size from the drop-down list according to the size of your
monitoring device.

@ NOTE:

» All the items in the “Region of Interest” should not be larger than the “Output Frame Size“
(current maximum resolution).

m The parameters of the multiple streams:

| Stream1 Fixed Fixed

Stream2 Fixed Fixed
Stream3 3840 x 2160 ~ 640 x 360 (Selectable) 3840 x 2160 ~ 640 x 360 (Selectable)

When completed with the settings in the Viewing Window, click Save to enable the settings and
click Close to exit the window. The selected Output Frame Size will immediately be applied to
the Frame size of each video stream. Then you can go back to the home page to test the e-PTZ
function. For more information about the e-PTZ function, please refer to page 135.

VIVOT=K IB9391-EHTV-v2

Region of Interest o=
(Viewing Region) e

Output Frame Size
(Size of the Live View Window)
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Click the stream item to display the detailed information. The maximum frame size will follow your
settings in the above Viewing Window sections.

Stream

= Video settings for stream 1

OH265
@H 264

Resalution
Maximum frame rate: 15 fps >
Intra frame period: 15 v
Smart stream II

Dynamic intra frame period ((help))

() Smart FPS

Smart codec

Mode

Quality priority: ((help) @ — .
Bit rate control
@ Constrained bt rate:
Target quality
Maximum bit rate:
Policy:
SmartQ
O Fixed qualty
OMIPEG
= Video seftings for stream 2
OH265
@H264
Resolution
Maximum frame rate. 301p v
Intra frame period
Smart stroa Il
Dynamic intra frame period ((hele))
() Smart £PS
Smart codec

Mode: Auto tracking v
Quality priority” ((help)) b —_—{— a

Bit rate control

@ Constrained bit rate:

Target quality. Detaled v
Maximum bit rate: 16 Mbps v

Policy:
SmartQ

O Fixed qualiy
OMIPEG

This Network Camera provides real-time H.265, H.264 and MJPEG compression standards (Triple
Codec) for real-time viewing. If the H.265 or H.264 mode is selected, the video is streamed via
RTSP protocol. There are several parameters through which you can adjust the video performance:

@H265
Resolution:
Maximum frame rate: s v
Intra rame period

Smart stream il

Dynamic intra frame period ({help))
O SmartFPS,
Smart codec

Mode
Qualty priorty: (help)) @ — .

Bit rate control

@ Constrained bit rate:

Target quality.
Masimum bitrte:
Policy.

Smart @ ON v

O Fixed quality

m Frame size
You can set up different video resolutions for different viewing devices. For example, you can
configure a smaller frame size and lower bit rate for remote viewing on mobile phones and a

larger video size and a higher bit rate for live viewing on web browsers, or recording the stream
to an NVR. Note that a larger frame size takes up more bandwidth.

m Maximum frame rate

This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother
video quality and for recognizing moving objects in the field of view.

If the power line frequency is set to 50Hz , the frame rates are selectable at 1fps, 2fps, 3fps,
5fps, 8fps, 10fps, 12fps, 15fps, and up to 25fps. If the power line frequency is set to 60Hz, the
frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 12fps, 15fps, and up to 30fps.
You can also select Customize and manually enter a value.
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The frame rate will decrease if you select a higher resolution.

m Intra frame period
Determine how often for firmware to plant an | frame. The shorter the duration, the more likely
you will get better video quality, but at the cost of higher network bandwidth consumption. Select
the intra frame period from the following durations: 1/4 second, 1/2 second, 1 second, 2 seconds,
3 seconds, and 4 seconds.

m Smart stream lli

m Dynamic Intra frame period
High quality motion codecs, such as H.265, utilize the redundancies between video frames to

deliver video streams at a balance of quality and bit rate.
The encoding parameters are summarized and illustrated below. The I-frames are completely

self-referential and they are largest in size. The P-frames are predicted frames. The encoder
refers to the previous |- or P-frames for redundant image information.

H.264/265 Frame Types

PIPPPPPPPI PPPPPPPI

By dynamically prolonging the intervals for |-frames insertion to up to 10 seconds, the bit rates
required for streaming a video can be tremendously reduced. When streaming a video of a
static scene, the Dynamic Intra frame feature can save up to 53% of bandwidth. The amount of
bandwidth thus saved is also determined by the activities in the field of view. If activities occur
in the scene, firmware automatically shortens the I-frame insertion intervals in order to maintain
image quality. In the low light or night conditions, the sizes of P-frames tend to be enlarged due
to the noises, and hence the bandwidth saving effect is also reduced.

Streaming a typical 2MP scene normally requires 3~4Mb/s of bandwidth. With the Dynamic Intra
frame function, the bandwidth for streaming a medium-traffic scene can be reduced to 2~3Mb/s,
and during the no-traffic period of time, down to 500kb/s.

Dynamic Intra Frame w/
(
@ A static scenes

[]

Static scene

PI PPPPPPPPPPPPPPPPPPPI

| .
55 > |
AN Dynamic Intra Frame w/
E 2 activities in scenes
P PPPPPPPI PPPPPPPIPPP Activities

I
I: > | < >
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With the H.265 codec in an optimal scenario and when Dynamic Intra frame is combined with
the Smart Stream function, an 80% of bandwidth saving can be achieved compared with using
H.264 without enabling these bandwidth-saving features.

m Smart FPS
In a static scene, the algorithm puts old frames in queue when no motions occur in scene. When
motions occur, the encoding returns to normal to deliver real-time streaming.

H-H-HHHH-

f1 f1 £l fi f5 f5 5 f5 {9

Moti Occur.

--HHHHE
f3 f4 5 f6 7 8 {9

f1 £l

By queuing the old frames from a static scene, both the computing efforts and the size of P
frames are reduced. It is beneficial for keeping up with the frame rate requirements.

A default frame difference threshold, 1%, is embedded in firmware for returning from Smart FPS
to normal encoding when motions occur.

#J NOTE:

Comparing with Smart Stream Il, Smart Stream Ill has two more configurable options: Smart Q,
and Smart FPS.
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Smart codec: Smart codec effectively reduces the quality of the whole or the non-
interested areas on a screen and therefore reduces the bandwidth consumed.

You can manually specify the video quality for the foreground and the background
areas.

Smart stream Il
Dynamic intra frame period (Help)

smart_codec:

Mode
Manual window setting
Quality priority: (Help) pv! {r 2

The user can adjust the quality balance between ROl (Region of Interest)
and non-ROl area. Moving the selector to the right side gives more quality

priority on ROl area, whereas moving the selector to the left side gives maore
quality priority on non-ROl area.

Select an operation mode if Smart codec is preferred.

- Auto tracking: The Auto mode configures the whole screen into the non-interested
area. The video quality of part of the screen returns to normal when one or
more objects move in that area. The remainder of the screen where there are
no moving objects (no pixel changes) will still be transmitted in low-quality
format.

- Manual: The Manual mode allows you to configure 3 ROl windows (Region of
Interest, with Foreground quality) on the screen. Areas not included in any
ROI windows will be considered as the non-interested areas. The details in
the ROI areas will be transmitted in a higher-quality video format.

As illustrated below, the upper screen may contain little details of your
interest, while the sidewalk on the lower screen is included in an ROI
window.

@i

non-interested

Restore | | Close | | Save




As the result, the lower screen is constantly displayed in high details, while the
upper half is transmitted using a lower-quality format. Although the upper half is
transmitted using a lower quality format, you still have an awareness of what is
happening on the whole screen.

ROl lower- quallty

- Hybrid: The major difference between the “Manual” mode and the “Hybrid” mode
is that:

In the “Hybrid“ mode, any objects entering the non-interested area will
restore the video quality of the moving objects and the area around them.
The video quality of the associated non-interested area is immediately
restored to normal to cover the moving objects.

In the “Manual” mode, the non-interested area is always transmitted using
a low-quality format regardless of the activities occurring inside.

Quality pricrity: {Help) v J 2

- Quality priority: Use the slide bar to tune the quality contrast between the ROI
and non-interested areas.

The farther the slide bar button is to the right, the higher the image quality
of the ROI areas. On the contrary, the farther the slide bar button to the left,
the higher the image quality of the non-interested area.

In this way, you may set up an ROl window as a privacy mask by covering a
protected area using an ROI window, while the rest of the screen becomes
the non-interested area. You may then configure the non-interested area to
have a high image quality, or vice versa.

You should also select the Maximum bit rate from the pull-down menu as the
threshold to contain the bandwidth consumption for both the high- and low-quality
video sections in a smart stream.



m Bit rate control
Constrained bit rate:

A complex scene generally produces a larger file size, meaning that higher bandwidth
will be needed for data transmission. The bandwidth utilization is configurable to
match a selected level, resulting in mutable video quality performance. The bit rates
are selectable at the following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps,
128Kbps, 256Kbps, 512Kbps, 768Kbps, 1Mbps, 2Mbps, 3Mbps, 4Mbps, 6Mbps,
8Mbps, 10Mbps, 12Mbps, 14Mbps, ~ to 80Mbps. You can also select Customize
and manually enter a value up to 80Mbps.

« - Target quality: Select a desired quality ranging from Medium to Excellent.

- Maximum bit rate: select a bit rate from the pull-down menu. The bit rate ranges
from 20kbps to a maximum of 80Mbps. The bit rate then becomes the Average or
Upper bound bit rate number. The Network Camera will strive to deliver video streams
around or within the bit rate limitation you impose.

- Policy: If Frame Rate Priority is selected, the Network Camera will try to maintain
the frame rate per second performance, while the image quality will be compromised.
If Image quality priority is selected, the Network Camera may drop some video
frames in order to maintain image quality.

Smart Q: Select ON or OFF to enable or disable the feature. Smart Q is scene-aware.
The Smart Q reduces frame size and bit rate consumption through the following:

m Dynamically adjusting the image quality for scenes in different luminosities in low
light frames. Less noises means less of the bandwidth consumed.

m Endorsing different qualities for the | frames and P frames, and hence reduces
the frame size.

m Dividing a single frame into different sections, and giving these sections different
qualities. For a highly complex area, such as an area with dense vegetation,

screen windows, or repeated patterns (complex textiles patterns like wall paper),
having a lower quality value actually poses little effects on human eyes.

Unnecessary quality is unrecognized by human eyes and wastes the bit rate.

The Smart Q streaming can save up to 50% to 80% of bandwidth in different
illumination conditions while keeping the same imaging quality. These numbers come
from the comparison between Smart Stream Il and Smart Stream Il streamings.



VIVOTEK

Fixed quality:
On the other hand, if Fixed quality is selected, all frames are transmitted with the
same quality; bandwidth utilization is therefore unpredictable. The video quality

can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

Maximum bit rate: With the guaranteed image quality, you might still want to place
a bit rate limitation to control the size of video streams for bandwidth and storage
concerns. The configurable bit rate starts from 1Mbps to 80Mbps.

The Maximum bit rate setting in the Fixed quality configuration can ensure a
reasonable and limited use of network bandwidth. For example, in low light conditions
where a Fixed quality setting is applied, video packet sizes can tremendously
increase when noises are produced with electrical gains.

You may also manually enter a bit rate number by selecting the Customized option.
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If the JPEG mode is selected, the Network Camera sends consecutive JPEG images to the client,
producing a moving effect similar to a filmstrip. Every single JPEG image transmitted guarantees
the same image quality, which in turn comes at the expense of variable bandwidth usage. Because
the media contents are a combination of JPEG images, no audio data is transmitted to the client.
There are three parameters provided in MUPEG mode to control the video performance:

Frame size: 19201020 v
Maximum frame rate:
Bit rate control

() Constrained bit rate:

(@ Fixed guality:
Maximum bit rate: 80 Mbps W

m Frame size

You can set up different video resolution for different viewing devices. For example, set a smaller
frame size and lower bit rate for remote viewing on mobile phones and a larger video size and
a higher bit rate for live viewing on web browsers. Note that a larger frame size takes up more
bandwidth.

m Maximum frame rate

This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother
video quality.

If the power line frequency is set to 50Hz, the frame rates are selectable at 1fps, 2fps, 3fps, 5fps,
8fps, 10fps, 15fps, and up to 25fps. If the power line frequency is set to 60Hz, the frame rates
are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 15fps, and up to 30fps. You can also select
Customize and manually enter a value. The frame rate will decrease if you select a higher
resolution.

m Video quality

Refer to the previous page setting an average or upper bound threshold for controlling the
bandwidth consumed for transmitting motion jpegs. The configuration method is identical to that
for H.264.

For Constant Bit Rate and other settings, refer to the previous page for details.

@ NOTE:

» Video quality and fixed quality refers to the compression rate, so a lower value will produce higher
quality.

» Converting high-quality video may significantly increase the CPU loading, and you may encounter
streaming disconnection or video loss while capturing a complicated scene. In the event of
occurance, we suggest you customize a lower video resolution or reduce the frame rate to obtain
smooth video.
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Media > Audio

Audio Settings

I Audio settings l IAudio clips

] Mute
Microphone source:
External microphone input gain: L 70%
Audio type

G711 pcmu v

(0) G726 bit rate: 32 Kbps v

Mute: Select this option to disable audio transmission from the Network Camera to all clients. Note
that if muted, no audio data will be transmitted even if audio transmission is enabled on the Client
Settings page. In that case, the following message is displayed:

The media type has been changed to video only because the media from server contains no audio

External microphone input: Select the gain of the external audio input according to ambient
conditions. Adjust the gain from 0% to 100%.

Audio type: Select audio codec and the sampling bit rate .

m G.711 also provides good sound quality and requires about 64Kbps. Select pcmu (u-Law) or
pcma (A-Law) mode.

m G.726 is a speech codec standard covering voice transmission at rates of 16, 24, 32, and 40kbit/
S.

When completed with the settings on this page, click Save to enable the settings.__
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Audio clips

m Output gain: Use the slide bar to change the audio output gains value.

m Audio clip: When the camera's audio input is connected to a microphone, you can record a
short period of audio recordings (1 to 10 seconds). You can also use the camera's embedded
microphone to record an audio clip, if available. Because the memory space is limited, a
recording count down will be available on screen.

You can also upload an audio file to the camera's flash memory. With amplified speakers, you
can playback the audio, e.g., to deter an intruder. A maximum of 2 audio clips in wav format are
supported. The maximum size of the audio file to be uploaded is 2,000Kbytes.

The voice alert is enabled in the Event settings > action > Play Audio Clip. The action
can be associated with triggering conditions.

Audio settings \ [ Audio clips ]

— Qutput gain

3 85%

— Audio clip

Add a new audio clip:

(@ Record a sound file (*.wav) from camera:

Mame: |

Wait for E seconds befare recording [1~10]

") Upload a pre-recorded sound file (*wav):

http://192.168.5.11. afrecord_audioclip.htmi?pre_second... ulal=h| .

Q http://192.168.5.111/setup/media/record_audioclip.htm|?pre_seconds=38name=deter

U
Recording... i

Remaining 55 seconds

, http://192.168.5.111 /setup/media/record_audioclip.html?p mﬁsmnd...lﬂij ]

| E http://192.168.5.111/setup/media/record_audioclip.html?pre_seconds=3&name=deter |

#,100% | Recording finished.

|

H100% v
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Media profiles

You can configure a different video stream for each of the 3 default profiles, Max. view,
Recording, Live view, and App.

The related video stream information will display, including stream number, resolution, codec
used, frame rate, etc. The Multicast port number, and address for video, audio, and Metadata
configuration will also be listed.

> Stream profiles setup
Prote name:

Always multicast for this stream profile

- Video configuration

Setup a video configuration

— Source
Stream No: Stream 1
Codec: H.264 Resolution: 2048x2048
Frame rate: 15 Bit rate (kbit/s): 6000000

— Multicast
Port: 15560 Address: 239.240.7.99
RTCP Port: 15561 Multicast TTL [1~255]: 15

- Audio configuration

Setup an audio configuration

— Source
Codec: G711
— Multicast
Port: 15562 Address: 239.240.7.99
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Network > General settings

This section explains how to configure a wired network connection for the Network
Camera.

Network Type [Wetwork type |

@ LAN
® Get IP address automatically
) Use fixed P address
Enable UPnP presentation
Enable UPnP port forwarding
© PPFOE

Enable IPvE

LAN ——

Select this option when the Network Camera is deployed on a local area network (LAN) and is
intended to be accessed by local computers. The default setting for the Network Type is LAN.
Please rememer to click on the Save button when you complete the Network setting.

Get IP address automatically: Select this option to obtain an available dynamic IP address assigned
by the DHCP server each time the camera is connected to the LAN.

Use fixed IP address: Select this option to manually assign a static IP address to the Network

Camera.
Network type

@ LAN

O Get IP address automaticaly

@ Use fixed IP address

passass
-
Default router:
by 1
-
Primary WINS server:
Secondary WINS server:

Enable UPnP presentation
Enable UPnP port forwarding
) PPROE

Enable IPvG

1. You can make use of VIVOTEK Installation Wizard 2 on the software CD to easily set up the
Network Camera on LAN. Please refer to Software Installation on page 28 for details.

2. Enter the Static IP, Subnet mask, Default router, and Primary DNS provided by your ISP or
network administrator.

Subnet mask: This is used to determine if the destination is in the same subnet. The default value
is “255.255.255.0".

Default router: This is the gateway used to forward frames to destinations in a different subnet.
Invalid router setting will disable the transmission to destinations across different subnets.
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Primary DNS: The primary domain name server that translates hostnames into IP addresses.

Secondary DNS: Secondary domain name server that backups the Primary DNS.

Primary WINS server: The primary WINS server that maintains the database of computer names
and IP addresses.

Secondary WINS server: The secondary WINS server that maintains the database of computer
names and IP addresses.

Enable UPnP presentation: Select this option to enable UPnP™ presentation for your Network
Camera so that whenever a Network Camera is presented to the LAN, the shortcuts to connected
Network Cameras will be listed in My Network Places. You can click the shortcut to link to the web
browser. Currently, UPnP™ is supported by Windows XP or later. Note that to utilize this feature,
please make sure the UPnP™ component is installed on your computer.

"% My Network Places ‘:”EHZ|
File Edit ‘“iew Favorites Tools Help #

e Back e @ p Search % Faolders v

Address ﬁ My Metwork Places Iv;| e

Local Network

Network Tasks @

Q Add a netwark place D ‘ireless Metwork Camera D Mega-pixel Network Camera (192.168.5.151)
(192,168.5.128)

% Wiew network conneckions T s il

a Set up a home or smal )

office network | wireless Metwork Camera with
ﬁ Wi workgroup computers PanTilt (192.168.5. 141}
= ===,

Enable UPnP port forwarding: To access the Network Camera from the Internet, select this option
to allow the Network Camera to open ports automatically on the router so that video streams can
be sent out from a LAN. To utilize of this feature, make sure that your router supports UPnP™ and
it is activated.

PPPoE (Point-to-point over Ethernet)

Select this option to configure your Network Camera to make it accessible from anywhere as long
as there is an Internet connection. Note that to utilize this feature, it requires an account provided
by your ISP.

Follow the steps below to acquire your Network Camera’s public IP address.

1. Set up the Network Camera on the LAN.

2. Go to Configuration > Event > Event settings > Add server (please refer to Add server on page
143) to add a new email or FTP server.

3. Go to Configuration > Event > Event settings > Add media (please refer to Add media on page
151).
Select System log so that you will receive the system log in TXT file format which contains the
Network Camera’s public IP address in your email or on the FTP server.

4. Go to Configuration > Network > General settings > Network type. Select PPPoE and enter the
user name and password provided by your ISP. Click Save to enable the setting.

— Network type

O LAN

@ PPPoE
User name:
Password:
Confirm password:

Enable IPv

_Save
5. The Network Camera will reboot.
6. Disconnect the power to the Network Camera; remove it from the LAN environment.
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ﬁ NOTE:

» If the default ports are already used by other devices connected to the same router, the Network
Camera will select other ports for the Network Camera.

» If UPnP™ is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.

» Steps to enable the UPnP™ user interface on your computer:
Note that you must log on to the computer as a system administrator to install the UPnP™
components.

1. Go to Start, click Control Panel, then click Add or Remove Programs.

Bi

Change or iz Apple Software Update
Remove " a
Programs Click here For suppart infarmation.

o

iadd e
Programs

& Tnstallation Wizard 1.18M8
8 Microsoft Office Prafessionsl Ediion 2003 Size  351.00MB
0 Mozilla Firefox (2.0.0.6) Size  20,34MB
5 PostarescL 8.2 Size  57.50MB
@ QuickTime Size  74.39MB

AddjRemove
windows
Components

) wirtual Machine Additions Size: 0,90MB
&' vivotek Installation Wizard 2 Size: 5.50MB — |
D VIVOTEK ST7501 Siee  66,96MB

@! Windows Genuine Advantage Yalidation Tool (KES92130)
@! windows %P Hotfix - KB323559
@ ‘windoves ¥P HotFi - KB328741
@ ‘windoves ¥P HotFii - KE333407

35 Windows %P Hotfix - KB335732
e T 3 ﬁ

Clase

3. In the Windows Components Wizard dialog box, select Networking Services and click
Details.

Windows Components Wizard |X\

Windows Components
You can add of remove components of YWindows P,

To add or remove a component, click the checkbox. A shaded box means that only
part of the component wil be installed. To see what's included in a component, click.
Details.

Components

]

Messag LOHE A

MB
0.3 MB

W F= | Irdate: Rt Certificates

Description:  Containg a variety of specialized, network-related services and protocals.

Total disk space required; 0.0MB
Details...
Space available on disk; 12125.4 MB

[ <Back [ Mew> | [ Cancel |
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4. In the Networking Services dialog box, select Universal Plug and Play and click OK.

Networking Services |X|

To add or remove a component, click the check box. & shaded box means that only part
of the component will be inztalled. To see what's included in a component, click Details.

Subcomponents of Metworking Services:

0.0ME
Simple 0.0 ME
"- Universal Plug and Play 0.2 mMe I

Description:  Listens for route updates sent by routers that use the Fouting Infarmation
Protocol version 1 [RIP«1].

Total disk space required: 0.0ME
Space available on digk: 121254 MB

Dretails...

i 0K i[ Cancel J

5. Click Next in the following window.

Windows Components Wizard

Windowsz Components
You can add or remove components of Windowes 3P,

To add or remove a component, click the checkbox. & shaded box means that only
part of the component will be installed. Ta see what's included in a companent, click
Details.

Components:

[ 52 Message Queuing 0.0ME |
¥ SN Explorer 13.5 MB
0.0mMB —EJ
1 =01 Inlate et Cetifinates nnme ¥
Descriptior:  Contains a variety of specialized, network-related services and protocols
Total dizk space required: 0.0ME
Space avalable on disk: 12125 4 MB =

[ < Back Ii Next il[ Canicel J

6. Click Finish. UPnP™ is enabled.

» How does UPnP™ work?
UPnP™ networking technology provides automatic IP configuration and dynamic discovery of
devices added to a network. Services and capabilities offered by networked devices, such as
printing and file sharing, are available among each other without the need for cumbersome
network configuration. In the case of Network Cameras, you will see Network Camera shortcuts
under My Network Places.

» Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on
the router-not HTTP port-meaning that you have to add the secondary HTTP port number to the
Network Camera’s public address in order to access the Network Camera from the Internet. For
example, when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, refer to
the list below for the Network Camera’s IP address.

http://203.67.124.123:8080 http://192.168.4.160 or
http://192.168.4.160:8080

» If the PPPoE settings are incorrectly configured or the Internet access is not working, restore
the Network Camera to factory default; please refer to Restore on page 57 for details. After the
Network Camera is reset to factory default, it will be accessible on the LAN.
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Enable IPv6

Select this option and click Save to enable IPv6 settings.
Please note that this only works if your network environment and hardware equipment support
IPv6. The browser should be Microsoft® Internet Explorer 6.5, Mozilla Firefox 3.0 or above.

— Metwork type

O LAN

@ PPPoE

Username: | |

Password: | |

Confirm password: | |

Enable IPvG

1PvE information
|| Manually setup the IP address

When IPv6 is enabled, by default, the network camera will listen to router advertisements and be
assigned with a link-local IPv6 address accordingly.

IPv6 Information: Click this button to obtain the IPv6 information as shown below.

close

[ethO address]
f280:0000:0000:0000:0202:d1f-feDe:d4cB/64@Link
[Gateway]

IPv6 address list of gateway

[DNS]

IPv6 address list of DNS

If your IPv6 settings are successful, the IPv6 address list will be listed in the pop-up window. The
IPv6 address will be displayed as follows:

Refers to Ethernet

[eth) address]

|2001:0608:2500:0002-0202:d1F:fe04 6554464 @Glokal —+—Link-global IPv6 address/network mask
|££80:0000:0000:0000-0000 1 £ £o04 656464 @Link ——Link-local IPv6 address/network mask
[Gateway]

|feED::211:dEff:feai:132b |

[DNZ]
|2D10:05u:ﬂ:9r?3d:: |
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Please follow the steps below to link to an IPv6 address:

1. Open your web browser.

2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.
3. The format should be:

http://[2001:0c08:2500:0002:0202:d 1ff:fe04:6 5f4]/

1

IPvé address

4. Press Enter on the keyboard or click Refresh button to refresh the webpage.
For example:

) Network Camera - Microsoft Internet Explorer

File Edit ‘“iew Fawaorites Tools  Help

‘eﬁack = e & IE @ @I’@Search %Favurites @‘ @' % 4’3

|
Address @ http://[2001:0c08:2500:0002:0202:d1ff:fe04:65f4]/

| Yviversk

WaW,. vwivoTE, Som

@ NOTE:

» If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage
using the following address format: (Please refer to HTTP streaming on page 106 for detailed
information.)

http://[2001:0c08:2500:0002:0202:d 1ff:fe04:65f4]/:8080

f )

IPvé address Secondary HTTP port

» If you choose PPPoE as the Network Type, the [PPP0O address] will be displayed in the IPv6
information column as shown below.

[ethD address]

|feEO:m03:m03:CC03:Oﬂm:dlffzfell:2299;64@1.1’:1}: |
[ppp0 address]

|££B0:0000:0000:0000:0202:d1 €71 1 229941 0@Link |
|2C01 B 0001 0000200021 £F-Fel 1 229905 @Cchal |
[Gateway]

|feED::93:1a03:4142:8aad |

[DNE]
|20:11 B0 |

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPvV6 server and router advertisements-enabled routers. If
you check this item, the following blanks will be displayed for you to enter the corresponding
information:
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Enable IPvG

1Pv6 information

Manually setup the IP address

Optional IP address / Prefix length |

Optional default router | |

Optional primary DNS | |
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Network > Streaming protocols

{J NOTE:

The metadata information can only be transmitted through the HTTP main port. Metadata is not available
through the secondary HTTP port.

HTTP streaming

To utilize HTTP authentication, make sure that your have set a password for the Network Camera first;
please refer to Security > User account on page 120 for details.

e e
Authentication:
HTTP port: 80
Secondary HTTP port: 8080
Access hame for stream 1: video1s1.mjpg
Access name for stream 2: video1s2.mjpg
Access name for stream 3: video1s3.mjpg
Access name for stream 4: video1s4.mjpg

Authentication: Depending on your network security requirements, the Network Camera provides two
types of security settings for an HTTP transaction: basic and digest.

If basic authentication is selected, the password is sent in plain text format and there can be potential
risks of being intercepted. If digest authentication is selected, user credentials are encrypted using MD5
algorithm and thus provide better protection against unauthorized accesses.

HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP port
is set to 8080. They can also be assigned to another port number between 1025 and 65535. If the ports
are incorrectly assigned, the following warning messages will be displayed:

Microsoft Internet Explorer. _ Microsoft Internet Explorer,
i' : HTTP part must be 80 or From 1025 to 65535 :! } Secondary HTTP part must be from 1025 to 65535

To access the Network Camera on the LAN, both the HTTP port and secondary HTTP port can be used
to access the Network Camera. For example, when the HTTP port is set to 80 and the secondary HTTP
port is set to 8080, refer to the list below for the Network Camera’s IP address.

http://192.168.4.160 or
http://192.168.4.160:8080

Access name for stream 1 ~ 3: This Network camera supports multiple streams simultaneously. The
access name is used to identify different video streams. Users can click Media > Video > Stream
settings to set up the video quality of linked streams. For more information about how to set up the
video quality, please refer to Stream settings on page 86.

When using Mozilla Firefox to access the Network Camera and the video mode is set to JPEG, users
will receive video comprised of continuous JPEG images. This technology, known as “server push”,
allows the Network Camera to feed live pictures to Mozilla Firefox.

106 - User's Manual




VIVOTEK

URL command -- http://<ip address>:<http port>/<access name for stream 1, 2, 3>
For example, when the Access name for stream 2 is set to video1s2.mjpg:

1. Launch Mozilla Firefox or Netscape.

2. Type the above URL command in the address bar. Press Enter.

3. The JPEG images will be displayed in your web browser.

) video2.mjpg {JPEG Image, 320x240 pixels) - Mozilla Firefox
File Edit Wiew History  Bookmarks Tools  Help {::

G- - @ @9 | nti/192.168.5.151videots2.mipg [x[ B [Cl]coock

EI Customize Links EI Free Hotmail EI Windows Media EI ‘indows

=)

&)

) NOTE:

» Microsoft® Internet Explorer does not support server push technology; therefore, you will not be able
to access a video stream using http.//<ip address>:<htip port>/<access name for stream 1, 2, 3> .

RTSP Streaming

To utilize RTSP streaming authentication, make sure that you have set a password for controlling the
access to video stream first. Please refer to Security > User account on page 120 for details.

HTTP | | RTSP

Authentication:

RTSP port: 554 ‘

RTP port for video: @

RTCP port for video:

RTP port for metadata: 6556

RTCP port for metadata: 6557

RTP port for audio:

RTCP port for audio: 5559

— Video

Multicast settings for
IP version:
Multicast video address: ‘ 239.240.7.99 ‘
Multicast video port:
Multicast video TTL [1~255]:

— Audio

Multicast settings:
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Authentication: Depending on your network security requirements, the Network Camera provides three
types of security settings for streaming via RTSP protocol: disable, basic, and digest.

If basic authentication is selected, the password is sent in plain text format, but there can be potential
risks of it being intercepted. If digest authentication is selected, user credentials are encrypted using
MD5 algorithm, thus providing better protection against unauthorized access.

The availability of the RTSP streaming for the three authentication modes is listed in the following table:

VLC
Disable o
Basic (0]
Digest X

Access name for Channel # and stream #: This Network camera supports multiple streams
simultaneously. The access name is used to differentiate the streaming source.
If you want to use an RTSP player to access the Network Camera, you HAVE TO set the video mode to
H.265 or 264 and use the following RTSP URL command to request transmission of the streaming data.
rtsp://<ip address>:<rtsp port>/<access name for stream1 ~ 4>
For example, when the access name for stream 1 is set to live1s1.sdp:
1. Launch an RTSP player.
2. Choose File > Open URL. A URL dialog box will pop up.
3. Type the above URL command in the address field.
4. The live video will be displayed in your player as shown
below.

A
=3

"1 A Open Media -

Playlist [ File @ Disc 22 Network [=F Capture Device
= Playlist Network Protocol
i Media Library Please enter a network URL:
MyiConputey risp/192.168.51.64:5< Mlive s sorlil

My Videos N I S—

My Music .

2 mples

[ My Pictures o

Devices http urtube.com.

) Discs
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RTSP port /RTP port for video, audio/ RTCP port for video, audio

m RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the port
number is set to 554.

m The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.

m The RTCP (Real-time Transport Control Protocol) allows the Network Camera to transmit the data by
monitoring the Internet traffic volume. By default, the RTCP port for video is set to 5557 and the RTCP
port for audio is set to 5559.

The ports can be changed to values between 1025 and 65535. The RTP port must be an even number
and the RTCP port is the RTP port number plus one, and thus is always an odd number. When the RTP
port changes, the RTCP port will change accordingly.

If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Microsoft Internet Explorer

" h Irvalid port number, RTP video port must be an even number,

Multicast settings for stream #1 ~ #3: Click the items to display the detailed configuration information.
Select the Always multicast option to enable multicast for streams #1 ~ #3.

— Video
Multicast settings for

IF version:
Muliicast video address: 239.240.7.99
Multicast video port:

Muilticast video TTL [1~255]

— Audio

Muliicast settings:
IF version:
Muliicast audio address: .240.7.99
Muliicast audio port: 15562

Mulficast audio TTL [1~255]:

— Metadata
Multicast seftings:
IP version:
Muliicast metadata address: .240.7.99

Multicast metadata port:

e

Multicast metadata TTL [1~255]:
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Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the other
hand, sends a stream to the multicast group address and allows multiple clients to acquire the stream at
the same time by requesting a copy from the multicast group address. Therefore, enabling multicast can
effectively save Internet bandwith.

The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an even
number and the multicast RTCP port number is the multicast RTP port number plus one, and thus is
always odd. When the multicast RTP port changes, the multicast RTCP port will change accordingly.

If the multicast RTP video ports are incorrectly assigned, the following warning message will be
displayed:

Microsoft Internet Explorer

:" : Invalid port number. Multicast stream 1 video port must be an even number,

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range a
packet can be forwarded. Each hop decreases TTL by one.

Initial TTL Scope

0 Restricted to the same host

1 Restricted to the same subnetwork
15 Restricted to the same site

64 Restricted to the same region

128 Restricted to the same continent
255 Unrestricted in scope

A IMPORTANT:

The Multicast metadata port is utilized by VIVOTEK VADP modules to transfer video analytics results,
PTZ stream, textual data, and event messages between the camera and the client side running and
observing the video analysis. If your client side computer is located outside the local network, you may
need to open the associated TCP port on routers and firewall.
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SIP

SIP is short for Session Initiation Protocol. If necessary, you can change the default port number,
5060, to one between 1025 and 65535.

Two way audio port:

The Network Camera supports two way audio communication so that operators can transmit and
receive audio simultaneously. By using the Network Camera’s built-in or external microphone and
an external speaker, you can communicate with people around the Network Camera.

Note that as JPEG only transmits a series of JPEG images to the client, to enable the two-way
audio function, make sure the video mode is set to H.264 on the Media > Video > Stream settings
page and the media option is set to “Media > Video > Stream settings” on the Client Settings page.
Please refer to Client Settings on page 46 and Stream settings on page 77.

«—

Audio transmitted to operators

L
4 oya

a0
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Network > DDNS

This section explains how to configure the dynamic domain name service for the Network
Camera. DDNS is a service that allows your Network Camera, especially when assigned
with a dynamic IP address, to have a fixed host and domain name.

Express link

Express Link is a free service provided by VIVOTEK server, which allows users to register
a domain name for a network device. One URL can only be mapped to one MAC address.
This service will examine if the host name is valid and automatically open a port on your

router. If using DDNS, the user has to manually configure UPnP port forwarding. Express
Link is more convenient and easier to set up.

J Express link | | Manual setup

Enable express link

http:// ‘ | 2bthere.net Help Save

By Express link, all users need to do is create host name for the camera. It will generate the link to
access the camera from internet,

Please follow the steps below to enable Express Link:

1. Make sure that your router supports UPnP port forwarding and it is activated.
2. Check Enable express link.

3. Enter a host name for the network device and click Save. If the host name has been used by
another device, a warning message will show up. If the host name is valid, it will display a
message as shown below.

Express link | | Manual setup

[¥] Enable express link

hitp:/l 0002D1123456 -2othere.net Helo  sae |

The ciamera can now be accessed at hitp:/000201123456.2bthere.net

2 Network Camera - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help

Qe - ©  [H B G P Frroms @3- 53 B

|&] https://0002D1123456.2bthere.net

}:mgg Mega-Pixel Network Camei
Video § lﬁl iBAuho-B SO%IB ZS%I

= Manual Trigger:
Digital Output [ 01 [
Focus Assist | on [57]
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Manual setup

DDNS: Dynamic domain name service

— DDNS: Dynamic domain name service

[] Enable DDMNS:

Praovider: | Dyndns.org{Dynamic) @|

Host name: | |

User name: | |

— I

Enable DDNS: Select this option to enable the DDNS setting.

Provider: Select a DDNS provider from the provider drop-down list.

VIVOTEK offers Safe100.net, a free dynamic domain name service, to VIVOTEK customers. It
is recommended that you register Safe100.net to access VIVOTEK’s Network Cameras from the
Internet. Additionally, we offer other DDNS providers, such as Dyndns.org(Dynamic), Dyndns.
org(Custom), TZO.com, DHS.org, CustomSafe100, dyn-interfree.it.

Note that before utilizing this function, please apply for a dynamic domain account first.

m Safe100.net

1. In the DDNS column, select Safe100.net from the drop-down list. Click | accept after reviewing
the terms of the Service Agreement.

2. In the Register column, fill in the Host name (xxxx.safe100.net), Email, Key, and Confirm Key,
and click Register. After a host name has been successfully created, a success message will
be displayed in the DDNS Registration Result column.

— Register
Host name: |WTK.lBafe‘IUU.net| |
Email: |wtk@v1vatek.cum |

Key: [TTY] Forget key
Conte ke -

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Register”.

DDMNS Registration Result:

[Register] Successfully Your account information has
been mailed to registered e-mail address

0

Upon successiul registration, you can clickg[u automatically upload relevant information to the

DDMS form or you can manually fill itin. Then, click "Save” to save new settings.

3. Click Copy and all the registered information will automatically be uploaded to the corresponding
fields in the DDNS column at the top of the page as seen in the picture.
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— DDN5: Dynamic domain name service

Enable DDNE:

Provider: |Safe1{]0.net Dg|

Host name: |WTK.safe‘|ﬂU.net | [*.safe100.nef]

Email: wik@vivotek.com
o -

— Register
Host name: |WTK.safe‘|ﬂU.net |
Email: |w1k@v1vctek.com |

Key: rene Forget key
Conti ey -

To apply for a domain name for the camera, or to modify the previously registered information, fill in

the following fields and then click "Register”.

DDMNS Reagistration Result:

[Register] Successfully Your account information has
been mailed to registered e-mail address

[0

Upon successful registration, you can click copy to automatically upload relevant information to the

DDMS form or you can manually fill itin. Then, click "Save™ to save new settings.

4. Select Enable DDNS and click Save to enable the setting.

m CustomSafe100

VIVOTEK offers documents to establish a CustomSafe100 DDNS server for distributors and
system integrators. You can use CustomSafe100 to register a dynamic domain name if your
distributor or system integrators offer such services.

1. In the DDNS column, select CustomSafe100 from the drop-down list.

2. In the Register column, fill in the Host name, Email, Key, and Confirm Key; then click Register.
After a host name has been successfully created, you will see a success message in the DDNS
Registration Result column.

3. Click Copy and all for the registered information will be uploaded to the corresponding fields in
the DDNS column.

4. Select Enable DDNS and click Save to enable the setting.

Forget key: Click this button if you have forgotten the key to Safe100.net or CustomSafe100. Your
account information will be sent to your email address.

Refer to the following links to apply for a dynamic domain account when selecting other
DDNS providers:
m Dyndns.org(Dynamic) / Dyndns.org(Custom): visit http://www.dyndns.com/
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Network > QoS (Quality of Service)

Quality of Service refers to a resource reservation control mechanism, which guarantees a certain
quality to different services on the network. Quality of service guarantees are important if the
network capacity is insufficient, especially for real-time streaming multimedia applications. Quality
can be defined as, for instance, a maintained level of bit rate, low latency, no packet dropping, etc.

The following are the main benefits of a QoS-aware network:
m The ability to prioritize traffic and guarantee a certain level of performance to the data flow.

m The ability to control the amount of bandwidth each application may use, and thus provide higher
reliability and stability on the network.

Requirements for QoS
To utilize QoS in a network environment, the following requirements must be met:

m All network switches and routers in the network must include support for QoS.
m The network video devices used in the network must be QoS-enabled.

QoS models

CoS (the VLAN 802.1p model)

IEEE802.1p defines a QoS model at OSI Layer 2 (Data Link Layer), which is called CoS, Class of
Service. It adds a 3-bit value to the VLAN MAC header, which indicates the frame priority level from
0 (lowest) to 7 (highest). The priority is set up on the network switches, which then use different
queuing disciplines to forward the packets.

Below is the setting column for CoS. Enter the VLAN ID of your switch (0~4095) and choose the
priority for each application (0~7).
— Cos

[#] Enable Cos

o .

Live videa: o -
Live sudia: D_"
Event/Alam: D_"'
Management: D_"

If you assign Video the highest level, the switch will handle video packets first.

ﬁ NOTE:

» A VLAN Switch (802.1p) is required. Web browsing may fail if the CoS setting is incorrect.

P The Class of Service technologies do not guarantee a level of service in terms of bandwidth
and delivery time; they offer a "best-effort.” Users can think of CoS as "coarsely-grained” traffic
control and QoS as "finely-grained"” traffic control.

» Although CoS is simple to manage, it lacks scalability and does not offer end-to-end guarantees
since it is based on L2 protocol.
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QoS/DSCP (the DiffServ model)

DSCP-ECN defines QoS at Layer 3 (Network Layer). The Differentiated Services (DiffServ) model
is based on packet marking and router queuing disciplines. The marking is done by adding a field
to the IP header, called the DSCP (Differentiated Services Codepoint). This is a 6-bit field that
provides 64 different class IDs. It gives an indication of how a given packet is to be forwarded,
known as the Per Hop Behavior (PHB). The PHB describes a particular service level in terms of
bandwidth, queueing theory, and dropping (discarding the packet) decisions. Routers at each
network node classify packets according to their DSCP value and give them a particular forwarding
treatment; for example, how much bandwidth to reserve for it.

Below are the setting options of DSCP (DiffServ Codepoint). Specify the DSCP value for each
application (0~63).

— QoS/DSCP

[#] Ensble QoS/DECF

Live wideo:

Live audia:

EventiAlam:

Management:

]
N
]
LI

Note that different vendors of network devices might have different methodologies and unique
implementations. Shown below is a sample corresponding information from a Cisco switch. You
should enter a DSCP tag value according to the information provided by the network devices.

Ingress DSCP | Output Queue Ingress DSCP | Output Queue Ingress DSCP | Output Queue Ingress DSCP | Qutput Queue

O(EE) 1w 16(CS2) 2 32(Cs4) 3v 48(CS6) 3v
1 1 17 2v 33 EXZ 49 EX QoS/DSCP
2 1w 1B(AF21) 2v 34(AF41) 3w 50 3y Enable QoS/DSCP
3 1w 19 27 35 3v 51 3v I Live vidoo: 32 0 I
4 1 20(AF22) 2v 36(AF42) EXZ 52 EX -
5 1w 21 2v a7 3w 53 3v Live audic: [
6 1w 22(AF23) 2v 38(AF43) 3w 54 3v Event/Alarm: l:l
7 ir 23 2v 39 ar 55 3v Management: l:l
8(C51) 1w 24(CS3) 3 40(Cs5) av 56(CST) EX
9 1w 25 3w M 47 57 3v
10(AF11) ir 26(AF31) iv 42 4r 58 3w
1 1 27 3v 43 av 59 3v
12(AF12) 1w 28(AF32) 3 44 47 60 3v
13 1 20 3 45 4v 61 3
14(AF13) 1 30(AF33) 3v 45(EF) av 62 3v
15 1w Tl 3w 47 47 63 3v
Queue 1 has the lowest priority, queue 4 has the highest priority.
i) [t [uReBNR OGS
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Application Layer3 Classification Layer 2 CoS/MPLS EXP
IPP PHB DSCP

IP Routing 6 CS6 48 6

Voice 5 EF 46 5

Interactive Video 4 AF41 34 4 QoS B

Streaming-Video 4 CS4 32 4

Locally-defined Mission- 3 - 25 3

Critical Data

Call-signaling 3 AF31/CS3 26/24 3

Transactional Data 2 AF21 18 2

Network Management 2 CS2 16 2

Bulk Data 1 AF11 10 1
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Network > SNMP (Simple Network Management Protocol)

This section explains how to use the SNMP on the network camera. The Simple Network
Management Protocol is an application layer protocol that facilitates the exchange of
management information between network devices. It helps network administrators to
remotely manage network devices and find, solve network problems with ease.

m The SNMP consists of the following three key components:

1. Manager: Network-management station (NMS), a server which executes applications that
monitor and control managed devices.

2. Agent: A network-management software module on a managed device which transfers the status
of managed devices to the NMS.

3. Managed device: A network node on a managed network. For example: routers, switches,
bridges, hubs, computer hosts, printers, IP telephones, network cameras, web server, and
database.

Before configuring SNMP settings on the this page, please enable your NMS first.

SNMP Configuration

Enable SNMPv1, SNMPv2c
Select this option and enter the names of Read/Write community and Read Only community
according to your NMS settings.

Enable SNMPy1, SNMPvZc

SHMPv1, SNMPv2c Settings

Read/\Write community: |F'rivate |

Read only community: |Pub|ic |

Enable SNMPv3
This option contains cryptographic security, a higher security level, which allows you to set the
Authentication password and the Encryption password.

m Security name: According to your NMS settings, choose Read/Write or Read Only and enter the
community name.

m Authentication type: Select MD5 or SHA as the authentication method.
m Authentication password: Enter the password for authentication (at least 8 characters).

m Encryption password: Enter a password for encryption (at least 8 characters).
Enable SNMPv3

— SNMPv3 Settings

Read/Write Security name: |Private |

Authentication Type:

Authentication Password: | |

Encryption Password: | |

Read only Security name: |F‘Ub|iC |

Authentication Type:

Authentication Password: | |

Encryption Password: | |
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Network > FTP

The newer firmware disabled the FTP port for security concerns. You can manually enable the FTP
server service to enable the FTP function. You can disable the FTP server function when it is not in use.

FTP port: The FTP server allows the user to save recorded video clips. You can utilize VIVOTEK's
Shepherd utility to upgrade the firmware via FTP server. By default, the FTP port is set to 21. It can also
be assigned to another port number between 1025 and 65535.

-"- Tips:

You can FTP the camera’s IP address to download videos recorded in the SD card, or use the “http://ip/
cgi-bin/fadmin/Isctrl.cgi?cmd=search” command to examine the recorded files on your SD card.

SETP:

This is the embedded SFTP client. Host Key: A host key is the SFTP server's public key.
Ensuring the SFTP server is validated is an important aspect of the SFTP protocol. It is
designed to protect against man-in-the-middle attacks where the hacker intercepts and
relays an impersonated message to the other party.

Click the Save button and the camera SFTP server MD5 key will display. The default
format is ED25519 and RSA.

— SFTP
Enable SFTF server
SFTP port
Host Key:

MOS:b0:fd:64:258:36:fe:80:2b:26red el 45:96: 22122142 (R34}
MO5:0e:ac:24:ba:0f:4b:03:09:70:a4:56:2b:db:ef:03:2e (EDZ25519)

Save
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Bonjour

To access the camera from a Mac computer, go to Safari, click on Bonjour and select the camera
from a drop-down list.

You can go to Safari > Preferences to enter your user name and password, and provide the root
password the first time you access the camera. The camera main page will open in your browser.

[ NoN ) Discovery

¥ local - 6 items
¥ _afpovertcp._tcp. (AFP over TCP)
¥ _companion-link._tcp.
»_csco-so._tep.
¥ _http._tcp. (World Wide Web HTTP)
¥ _rtsp._tep. (Real Time Streaming Protocol (RTSP)) - 1 items
Network-Camera.local.
192.168.0.15:554
path=live.sdp
P _smb._tcp. [Server Message Block over TCP/IP)

Some later iOSes may come without the Bonjour option. Install the Discovery utility instead.

Find the Discovery (formerly Bonjour Browser) from the Mac App Store.

Discovery is a utility that displays all the Bonjour services on your local network or on Wide-Area
Bonjour domains. The utility is previously called Bonjour Browser, it is now distributed on the Mac

App Store.

Discovery requires macOS 10.12 or higher. For older versions of Mac OS you can download the
old version of Bonjour Browser.

Bonjour Browser (obsolete)
http://www.tildesoft.com/files/BonjourBrowser.dmg - Version 1.5.6

Discovery for iOS
https://itunes.apple.com/us/app/discovery-dns-sd-browser/id3054410177?mt=8
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Security > User accounts

This section explains how to enable password protection and create multiple accounts.

Account management

Security > User accounts

| Account management | | Privilege management |

[--New user— w|
User name: |fmnt_t:uard |
User passwor{j: |l.l.....l.l... | Medium

* At least 8 characters with no space, one alphabet character and one numernic character

Confirm user password: |"l"nnn-n |
Privilege: v
[ peete || Add [ Update |

The administrator account name is “root”, which is permanent and can not be deleted. If you want

to add more accounts in the Account management window, please apply the password for the “root”
account first.

The administrator can create up to 20 user accounts.

To create a new user,

1. Click to unfold the pull-down menu. Select New user.

2. Enter the new user’s name and password. Type the password identically in both text boxes.

Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

The strength of your password combination is shown on the right, use the combination of

alphabetic, numeric, upper case, and lower case characters until the password strength is good
enough.

3. Select the privilege level for the new user account. Click Add to enable the setting.
The privilege levels are listed below:

Administrator |Full control

Operator Control DO, white-light illuminator, snapshot, and PTZ;
unable to enter the camera Configuration page.
Viewer Control DO, white-light illuminator, view, listen, PTZ, and talk through the

camera interface.

Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only
administrators can access the Configuration page. Although operators cannot access the
Configuration page, they can use the URL Commands to get and set the value of parameters. For
more information, please refer to URL Commands of the Network Camera on page 161. Viewers
can only access the main page for live viewing.

Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.

2. Make necessary changes and click Update or Delete to enable the setting.
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Privilege management

|Accnunt management ‘ ‘ Privilege management

Operator: Digilal oulpul PTZ control

Viewer: [] Digital eutpLt PTZ control

_sae |

Digital Output & PTZ control: You can modify the management privilege as operators or viewers. Select
or de-select the checkboxes, and then click Save to enable the settings. If you give Viewers the privilege,
Operators will also have the ability to control the Network Camera through the main page.
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Security > HTTPS (Hypertext Transfer Protocol over SSL)

This section explains how to enable authentication and encrypted communication over
SSL (Secure Socket Layer). It helps protect streaming data transmission over the Internet
on higher security level.

Create and Install Certificate Method

Before using HTTPS for communication with the Network Camera, a Certificate must be created
first. There are three ways to create and install a certificate:

Create self-signed certificate

1. Select this option from a pull-down menu.

2. In the first column, select Enable HTTPS secure connection, then select a connection option:
“HTTP & HTTPS” or “HTTPS only”.

3. Click Create certificate to generate a certificate.

— HTTPS
Enable HTTPS secure connection
= Mode:
® HTTP & HTTPS © HTTPS only
Please wait while the certificate is being

= Certificate: generated...
Gertifcate information o ______|
Status: Not installed
method: | Create self-signed certificate =
Country: IEI
State or province: | Asia |
Locaity: Asia |
Organization: VIVOTEK inc |
Organization unit: |VN0TEK.Inc |
Common name: | whww vivotek.com |
Validity: days

4. The Certificate Information will automatically be displayed as shown below. You can click Certifi-
cate properties to view detailed information about the certificate.

Certificate information

Status: Active

method: Create self-signed certificate
Country: W

State or province: Asia

Locality: Asia

COrganization: VIVOTEK.Inc

Organization unit: VINOTEK.Inc

Common name: www vivotek.com

Certicate roperes
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5. Click Save to preserve your configuration, and your current session with the camera will change
to the encrypted connection.

6. If your web session does not automatically change to an encrypted HTTPS session, click Home
to return to the main page. Change the URL address from “http://” to “https://“ in the address bar
and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.

https://

‘A Network Camera - Microsoft Internet Explorer,

File  Edit

ew  Favorites  Tools  Help
GBack < @ B @ @ pSearch if}?Favorites e‘ @v % 4’“
Addres: g_https://I92.168.5.151/index.htm|

XVIV@'IEI( Mega-Pixel Network Camera

Www.vivoTEw.CcOom
T Client settings | Configura

Video stream: 1 -

& Manual triggers:

Digital output:

Focus assist:
PTZ control.  Digital :

o I Security Alert
P

= x g ‘You are about to view pages over a secure connection.
[ Pan | stop | Patrol e - Ay information you exchange with this site cannot be
e i 0 - 4 . J vigwed by anyone elze on the 'web.
Tilt speed: [ - 5 .' [ I the Future, do ot show i warning
Z St : o - : i ]S i [ Moare Infa ]
w Global view: : :
Security Alert [x] Security Information Y
rir“'l Information vou exchange with thiz s_ite cannat be yiewed or r,"ﬂ Thiz page caontains both secure and nonsecure
?. changed by others. However, there iz a problem with the site’s ?. items.
- secunty certificate. &

Do pou want to display the nonsecure items?
The zecurity certificate was izsuad by a company vou have
not chosen to trust. Yiew the certificate to determine whether
you want to trust the certifying authority,

E Tes ” Mo J[ Mare |rfia ]

a The zecurity certificate date iz walid.

The name on the security certificate iz invalid or does not
rnatch the name of the: site

Do you want to proceed?

[ Yes ] L Mo i [\-"iew Eertificate]
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Create certificate request and install

1. Select the option from the Method pull-down menu.

2. Click Create certificate to proceed.

3. The following information will show up in a pop-up window after clicking Create. Then click Save
to generate the certificate request.

< Certificate:
Cefrtificate information
Status: Not installed
Method: | Create certificate request and install E||
Country:
State or province: |nsia |
Locality: |a5|a |
Organization: | VIVOTEK Inc. |
Organization unit: |VIVOTEK Inc. |
Commaon name: |www.v1\f0tekcorn |

Please wait while the certificate is being

4. The Certificate request window will prompt.

€ htip://192.1¢

— Create certificate request completed

Copy the PEM format request below and send it to a CA for identify validation. After that, you have to install it
by clicking the "Upload™ button on HTTPS page.

— Certificate req {PEM

BEGIN CERTIFICATE REQUEST-———-—
MITBs=CCARWCAQIwozELMAKCAI UEBhMCVF cxDTALEgNVBAGTEEFzaWExDTALEGHN Y
BACTBEFzZaWEXFIATE oTIDFZJVkIURU: JLIEVMBMGRIUECXMMVEKIWT1RF
SyB OV 3cudml 2h3R1ay5 b2 0wgZEwDOY TEoZ ThveNAQER
BRADGY0OAMICIRAoCBALEFSjkjhlCcufOHpd 3£0HUngCEPLQ8zi B 4HCTbr svhpun/W
ADZJRAYEHShLOwEpmpsMy3crSYtulJuGTbkbLAUHN/ T3 7RAvVZAUCOXEvIMSAgZISI e
ZpnCIZP¥59L244VnhuairewvwR1VHONEixf1lodDZUEKmC3UHBpNLBES IS TvASAgME
BREgADANEgkghkiGIwlBAQUFAROBgRBAQgpKdUL chbwd 1 REnEUSEEMEnBr i KHmQY
rk/iglTELEXPWESKRALgi3I4XpFN]AVBUs0LwUCOCh/ nyHRScZaZ tEZWiSJhD1ALIFm
IZXNPLIAvCA6220hobqT9e SILEEVL lwClpRXNmoEulgNz dM¥VyzRgd3zoeQuZsSVz
SMxxriluow=—

————-END CERTIFICATE REQUEST--————

If you see the following Information bar, click OK and click on the Information bar at the top of
the page to allow pop-ups.

3 HTTPS - Microsoft Internet Explorer

File Edit Wew Faworites Tools Help

Qi © X B G P frrwone @ 2- 258

Address @ httpi//192,168.5, 151 fsetup/https. html
& Pop-up blacked, To see this pop-up or additional options click here. ..

Home Qe liil[NeVGLE Language

)
L=ty > HTTPS

System

Information Bar,

Security Did you notice the Information Bar?
User account The Information Bar alerts you when Intemet Explorer blocks a
pop-up windaw ar file download that might nat be safe. If &

HTTPS ‘web page doss not display properly, look far the Information
Bar (near the top of your browser)

Access list

|EEE 802.1% (] Do not shaw this message again.

[r— Leamn about the Information Bar.
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5. Look for a trusted certificate authority, such as Symantec’s VeriSign Authentication Services, that
issues digital certificates. Sign in and purchase the SSL certification service. Copy the certificate
request from your request prompt and paste it in the CA’s signing request window. Proceed with
the rest of the process as CA’s instructions on their webpage.

i e AL Svmentec rust Center e, B_ﬁ

Help & Support | Feedback

@Symantec. Trust Center
___________________________________________________________________|
Free Trial > 1)Cptions = 2) Techrical Cortact 3= 3)CSR = 4) Sumimary ChaIAWIIIhU: - l

Enter Certificate Signing Request (CSR)

Server platrorm: & Sample CSR Order details
Selectone hd Symantec™ SSL Test Certificate

» Walidity period: 30 days

St A
S aE e ;

401 DTN VR ZIZ KM L Jod VINES Oy 2T WES M Total: (Free Trial) us fo
,,,,, BT GATE nEoUEST

Paste Certificate Signing Request (CSRy: &

MIBS]CCARSCAGIWEELMA kG A1 LESHMCYF cxDT ALBgNYB AGTBEF 28V EXDTALBNY
Bt TEEF 28 WEF TA TEghYERA 0 TDF Z)VkSURUsgEWSILIEY MBMG A1 LECMMVKIATI RF .
B. QYDVQED MLIAMTCyLmivbT CBriz ANBkhKIGSw B AGEF @ Whatis aCSR?
OB AWV VEAZITS 2y 29 LBEDT R+ Dok LINL cirva260H sef 20V 3pS
E1Gn+HEGOG2NREDEL shDF QEEEANIDE gEGhCI 2SR O H CKYEEYOXGZGRI A CBR s generated from your server and is
3BFbGUQrmePBmNg\PKCSUTNFI\ch;kYOsRtFKQZBgymocFe;@cuSequcAwEA your server's unigue "fingerptint'. The CSR
1GSh3DEEEEGELU. Gk Icr GRS hD2PSlbk4LIOF TRSGimAr includes your server's public key, which
TRACvrELEImgSY 2aNzVECyZalEY PRDGZRGLYAUOWI Py Boe Y 329B0JHSIOf enables server authentication and secure
DG HRPIMG 3K DSIME] ANIBC 25T 7 aPiphNGEF by communication
Y2 Mz he ceneratin 8 CSR? ==
-END CERTIFICATE REGUEST -

Total: US 0 (Free Trial) < Back Cancel Continue

TRUSTe Gt

| pone =

6. Once completed, your SSL certificate should be delivered to you via an email or other means.
Copy the contents of the certificate in the email and paste it in a texttHTML/hex editor/converter,
such as IDM Computer Solutions’ UltraEdit.

immediately, please dial 866.893.6565 or 650.426.5112 option 3 or send an email to internet-sales@verisign.com

Thank you for your interest in Symantec!

MIIFBDCCA+yaRWIBRQIQFx1Cahn/S5eBSit0WQDOBIzANEgkghkiGIw0BAQUFADCE
yZELMAkGA1UEBhMCVVMAFZAVBQNVBA0TD1Z 1cml TaWdu LCBIbmMuM T AWLgYDVRQL
EydGb3IgVeVzdCBQdEJwb3N1cyBFbmx SLiAgTMEgYXNZdXJhbrN1cy4xQ] BABQNV
BASTOVR1cmlzIG9mIHVZZ5BhdCBodHRwez0vL3d3dy52ZXdpc21lnbi5]b20vY3Bz
L3R1c3R] YSAoYykwOTEtMC3GA1 UEARMKVIVyaVNpZ 2 4gVHIpYiwg 2V dXJ1 TFN1
cnZlciBDQSAtIEcyMB4XDTEyMDcwMz AwMDAWMFoXDTEyMDgwMj IzNTk10Vowgadx
CzAJBgNVBAYTA] REMQOWCWYDVQRTEWREC2 1 hMQOWCW Y DVQHFAREC2 1 hMRIWEWYD
VOQKFAXWSVEZEVEVLIEluYy4xFTATBQNVEASUDFZ JVk SURUsgSWSLIEGMDgGRIUE
CHQRVEVYbXMgh2 YgdiN1 IGF0THA3dy52 2K Ipc21nbi5 b2 0vY 3BZL3R1 c3R] Y54n
¥ykwNTEXMBUGALIUERAxQOd3d3LmZ 10DE 3Mi55b2 0wgZ EwDQY JKoZ ThwcNAQEEBQAD
g¥ORMIGJIAGGRANI TEOtr8KGTeC+hAIUYFrgeXZCyTS3a T2 tunRyLEpdlid6eodR.
p/h+ajhtpIUQg5CT INwxUBBCEFp/ Q4 x I FBoQPWUGS0Z 0GR/ gqgimARK] LxsxkFH/R
Wx1IKSnlzwhkloCDygrFEZRSCMOvI45GDrEbRSkNuoMpgRhXo0KoOnggTAgMBARG]
QgOGEMIIBITAZEgNVHREEE] AQgg53d3cuZml4MI cyLmNvbTAJEQNVERMEL J ARMALG
R1UdDWEB/wQEAWIFoDBDBgNVHR2EPDAEMDigNgROh] JodHRWOiSvI1ZSVHIpY Wt
RzItY¥3JslnZlcmlzaWdulmNvb59TV1JUcmlhbEcyLmNybDEKBQNVHSAEQZEEMDEG
CrCESAGE+EURBXTWMT AvEggrBgEFBcCARY § aHRO cHMALy 9 3d 3cudrVyaipZ24u
¥29tL2NwcyI0ZXNOY 2EWHQYDVRO1BEYWEAY IKWYBBQUHAWEGCCaGAQUFBWMCMBEG
R1UdIw)YMBaAFCoXE4q91qK] 3AY=t7a02hBnYG7 IMEQGCCaGAGUFEWERRGWE Ak
BggrBgEFBQCowAYYYaHROcDovL29] c3AudnVyaXNpZ 24u¥29tMD4GCCaGAQUFBAC
hjJodHRwOiEvULZSVHEIpYRwtRzItYWlhLnZ loml zaWdulovb STVl JUcmlhbEcy
LmN1cjANBgkahkiGOwOBAQUFAROCAQERTXUHTFnIae/X7T62/ 22r9ZEKNLESEQSD
qaNcEawinSclZ9Fp3kzEKvpaICLEFSMbrOPGIPalLFXAEUITr SW1SCoXRR1AIWpl2
qVSbDExgVMRX9T Trd20URzims6i feM5Ttub3Qc2Tu3pRe AKbAH/ T+x+0] GOEVB3zZ
cPaShn/gcapKcqlXvHycwHeCWNERQaGci368qkPzasvToErbnLhupjdxUESGExU
IM13CErAtQZviRad]l fIQYSTgS0Ng2mA SghdEuKTnhCHUwwgOxNBuce ITE3ITPKTO
meCo¥YpntblgmFey] 9EvgIUdceYZImn2B0qScSq3iZARPH/ gl/f /EeGg=—=
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7. Open a new edit, paste the certificate contents, and press ENTER at the end of the contents to
add an empty line.

@ [Edit1#] - UltraEdit 10l x|
File Edit Search Insert Project Wiew Formabt Column Macro Scriphing  Advanced  Window Help
e e eE e e EEEE BEEB @Y
g
ijactl open  Explorer |Lists | A1) Editl % g
1| =
Filter: I * > IID I
I
w1 A oo 10 o 201 30 0 BB BB E
e 12 [ CCGEAGG+EUBExUvNTAvEggr BgEFBQoCARY JaHROcHMALy93di cudnWyaNp 22 4u
et 15 (¥29tL2Nweyd0 ZENOY2 EwHQYDVRO IBEYwF AY IKwYEBQUHAWE GC CaGAQUFEwMCMESG =
? E . 20 |A1TdIWQTHEaLF CoXE4qo1gK13 A¥at 7a02 hBMYGT7 LMHQGCC2GLOUF BWEBEGoWE ] Lk =
% F':;"";’ . 21 |BgurBYEFBQew LYY YaHROeDovL2 99 03 AudniiyaXin 22 4uY2 9t HD4GCCSGLOUF Bz AC 2
-
ceounes 22| by JodHRWO1EvT1ZSVHIpYHWE Rz It TW1ALYNZ Loml zaWdulmlivh 39 TV 1 JUcml hhE ey 2
22| L 1o J ANBgkghkiGoOwOB AQUF AROC AQEATHuHYFnIae,/ X7T6z/ 22r 92EEhLESEQSp =
Z4 |gqalcEswidic1Z9P p3keEEvp 6 TCLPSMbrOPGI PRl LFx AEUITr3 W1SCoXWRIAUp 12 |
25| qVSbD fxgVHiTx 9 T7rd2 0URz jms 6 i foM5 Thub3 0o 2 Tud pile AKb AH/ T+x+0] G0EVES = —
26 |cPaShn/ qeapKeg0XvHyc wHe CUNEROgsGe 13 65gkPessvToErbnLhup jdx UESGExu g
27 [3MLGCEC ACQEviRadlfJOT STyl 0NgZ mASghdEuKTnhC HUluvwgOxN8uce IIS3 ITPETD =
4 Name Date modifiec A ) . T
mECoTpnthlowF ety 9EvgIUde 6 YE Inn2 BOgSe 53 iZARPH gi/ f EeGg== Z
(=
=
=
=
o
5
o}
3
< | | -

8. Convert file format from DOS to UNIX. Open File menu > Conversions > DOS to Unix.
(@ [ viabdie R =

File Edit Search Insert Project View Format Column Macro  Scripting  Advanced Window Help

[ tew Gt BT RER EEEE OB @S
& Open... Chl+O
¥ Quick Open... Chr+0) =
Close =
-]
05 Closs Al Flles Chel+Shift+F4 2
@ Close All Files Except This %
¢ o
FIP{Telnet v I L S ) L S L A . | L W] LA ) P . =
= GEAGG+HEUBExUwMTAYVEygrBgEFEQuCARY jaHROcHMELy93d3 cudVyaXNp 22 4u
@ Revert bo Saved CLZNweyI0 ZENO0 Y2 EwHQYDVED1BEYTwEF AY IKw TEBQUHAWE GC C s GAQUFBEwHCMESG =
IwQTHEaAF CgXE4o9 1K1 AYst 7a02 hBn Y67 IMHQGCCsGAQUF BwEBBGywE S Ak =
B save Chrkts rEgEFEQewAYTYaHEROeDovL2 0 el Audnyaip 22 4u¥2 0eHD4GCCsGAQUF B AC g
E Save As... Fiz odHRwOi8vT1Z3VHEIpTwt Rz It TU1hLnZ leml ealdulnlvh 38TV 1 Ul hbEcy E
% Save All Al+F12 1o ANBgkahkiGOwOBAQUFALOC AQEAT®uH?Fnlae/ X7T6e/ z2r 92 EKWLESEQSp &
a i Salaction £ Cc8swikSelIoPpikeERvp 6TCLPSMbrOPGIPalLFxAEUITE3WISCoXWRLIAIUp 12
- - - D ERgW MO T7rd2 oURz jms 6 ifeMETEwo3 Qo2 Tul pe kb AR/ T+x+0jGOEVEI = ]
% () i Shn/ gqoapKeg0ivHyc wHe CUNERQg=sGe 13 68kPzssvioErbnLhup Jdx UESGExu Lgn
Encryption P PCErACQZviRadlfJOYSTgI0NgZmASghdEuKTnhCHUwyqOXxNEuce IIS3 ITPKYD ?
3 ; TpnthlonFtyi9EvgIUdesYEInn2 BOgSeSqg3 iZARPHS gi/ / XeGg== @
= Benemer __END CERTIFTCATE-————
(& Compare... AlE+F1L =
Sotk 3 E
LUNIZMAC to DOS =
o
Special Functions » B DOS to MAC EE
il
Print... Chrl+P -
Print All Files % EBCDIC ko ASCIT =
Print Preview % ASCII ko EBCDIC
Print Setup/Configuration 3 % OEM ko ANST
E Favarite Files... Chrl+Shift+F % ANST ko OEM
agmnt s » 5 ASCIIto Unicode
Recent Projects/\WorkSpace Y B (T b Unicode
B e ™ Uricode b A5CIL
r
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9. Save the edit using the “.crt” extension, using a file name like “CAcert.crt.”

File Edit Search Insert Project Wiew Format Column Macro  Scripbing  Advanced  window  Help

@& B REE

53 e N s n!z

i My Documnents &UItraCompare
: a My Computer @UltraEdit
& My Network Places & YTYOTEK
= i Adobe Reader 9 ) BlackholePmzs AR (13 Blackhole)
S DI: K74 FileZila Client [Ty Mew Folder
g 'E ¥ Google Chrome 44
N;atwork e Installation Wizard 2 @45
FTF &ccounts 5 LiveClient 46
McAfee Security Scan Plus 802. 1
ap Milestane ¥Probect Smart Client 802. 1x-1
B Mozilla FireFax [ s0z.1%-2

% Playback.

(A QuickTime Player
£ RealPlayer @activerlugin
] Teamviewer & @activerluginl

A Name I Drate modifisc

i

Save I
Cancel |

File name: IC.*’-\celt.crt

Save as type: IAII Files, "]

L L L

Line Terminator: IDeFaU":

Format: IDEFauIt

Kl

Leave as "Default” for normal use, or change it
CONYESION On Save required,

ADS Stream: I j

(&It Data Stream is only far fles on MTES drives)

A
= o
EEEEE TN amEwmBVeRad DEE; 0B ERL s

10. Return to the original firmware session, use the Browse button to locate the crt certificate file,
and click Upload to enable the certification.

A NEW DEFRATION OF HD Home Client settings ELLul'MeudlLE Language
Security > HTTPS

System

— HTTPS
Media [¥ Enahble HTTPS secure connection
Network = Mode:
i & HTTP & HTTPS { HTTPS only
User accounts e Certificate:
HTTPS Certificate information
Access list Status: Waiting for certificated
IEEE 802.1x Select certificate file: C\Documents and Se ?Emwse..é| Upload |
PTZ Method Create cerificate request and install
Event Country: T
. State or province: Asia
Applications
Locality: Asia
Recording Organization: VIVOTEK Inc
Local storage Organization unit: VIVOTEK Int
Comrmon harne: whai ivotek com

| Basic mode | Remove certificate |
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11. When the certifice file is successfully loaded, its status will be stated as Active. Note that
a certificate must have been created and installed before you can click on the “Save"
button for the configuration to take effect.

— HTTPS

= hiode:

& HTTP &HTTPS ¢ HTTPS only

w Certificate:

Certificate information

Status: Active

Method: Create cedificate request and install
Cauntry: T

State or province: Azia

Locality: Azia

Organization: WIVOTEK Inc.

Qrganization unit: YIVOTEK Inc.

Comman name: weanie vivotek.com

Certificate properties Remove cerificate |

Save |

12.To begin an encrypted HTTPS session, click Home to return to the main page. Change the URL
address from “http://” to “https://“ in the address bar and press Enter on your keyboard. Some
Security Alert dialogs will pop up. Click OK or Yes to enable HTTPS.

Sgcority, Alert (x) Security Information | x |
“'ou are about to view pages over a secure connechion, This page contains both secure ahd nonsecLre
Any information pou exchange with this site cannot be @ hers.

viewed by anpone elze on the Web. . .
Do pou want to digplay the nonsecure iterns?

[ I the future, da nat show this warming

[ k. “ Mare Infa J i Yes ” Ma ][ tore Info ]

Security Alert |X|

changed by others. However, there iz a problem with the site's

g Information you exchange with thiz site cannot be viewed or
zecunty certificate.

& The zecurity certificate was izsued by 3 company you have
not chosen o trust, Yiew the certificate to determine whether
wou want to trust the certifping sutharity.

° The secunty certificate date iz valid.

& The name on the zecunty certificate iz invalid or doez not
match the name of the site

Do wou want to proceed?

[ Yes ] i Mo i ['V'iew Certificate ]
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Security > Access List

This section explains how to control access permission by verifying the client PC’s IP
address.

General Settings

Maximum number of concurrent streaming: [ Connection management ]

|’ General settings

Maximum number of concurrent streaming connection(s) limited to: Simultaneous live viewing for
1~10 clients (including stream 1 to stream 3). The default value is 10. If you modify the value and
click Save, all current connections will be disconnected and automatically attempt to re-link (IE
Explorer or Quick Time Player).

View Information: Click this button to display the connection status window showing a list of the
current connections. For example:

IP address Elapsed time User ID
Il 17216.2.53 00:00:05

Il 192.168.4.104 01:49:35

Refresh Add to deny list Discannect Close

Note that only consoles that are currently displaying live streaming will be listed in the View
Information list.

m |IP address: Current connections to the Network Camera.
m Elapsed time: How much time the client has been at the webpage.

m User ID: If the administrator has set a password for the webpage, the clients have to enter a
user name and password to access the live video. The user name will be displayed in the User
ID column. If the administrator allows clients to link to the webpage without a user name and
password, the User ID column will be empty.

There are some situations that allow clients access to the live video without a user name and

password:

1. The administrator does not set up a root password. For more information about how to set up
a root password and manage user accounts, please refer to Security > User account on page
120.

2. The administrator has set up a root password, but set RTSP Authentication to “disable”. For
more information about RTSP Authentication, please refer to RTSP Streaming on page 107.
3. The administrator has set up a root password, but allows anonymous viewing. For more

information about Allow Anonymous Viewing, please refer to page 120.
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m Refresh: Click this button to refresh all current connections.

m Add to deny list: You can select entries from the Connection Status list and add them to the
Deny List to deny access. Please note that those checked connections will only be disconnected
temporarily and will automatically try to re-link again (IE Explore or Quick Time Player). If you
want to enable the denied list, please check Enable access list filtering and click Save in the
first column.

m Disconnect: If you want to break off the current connections, please select them and click this
button. Please note that those checked connections will only be disconnected temporarily and
will automatically try to re-link again (IE Explore or Quick Time Player).

Filter

Enable access list filtering: Check this item and click Save if you want to enable the access list
filtering function.

Filter type: Select Allow or Deny as the filter type. If you choose Allow Type, only those clients
whose IP addresses are on the Access List below can access the Network Camera, and the others
cannot. On the contrary, if you choose Deny Type, those clients whose IP addresses are on the
Access List below will not be allowed to access the Network Camera, and the others can.

— Filter
Enable access listfiltering
Filter type: ) Allow @ Deny

IPv4 access list

IPv6 access list

Then you can Add a rule to the following Access List. Please note that the IPv6 access list column
will not be displayed unless you enable IPv6 on the Network page. For more information about
IPv6 Settings, please refer to Network > General settings on page 99 for detailed information.
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There are three types of rules:
Single: This rule allows the user to add an IP address to the Allowed/Denied list.
For example:

Filter address

Rule
IP address: | 192.168.2.1

[_ox [ cancel |

Network: This rule allows the user to assign a network address and corresponding subnet mask to
the Allow/Deny List. The address and network mask are written in CIDR format.
For example:

Filter address

Metwork address / Network mask: 19216820 | ! |24 |

ok ][ cancel |

IP address range 192.168.2.x will be bolcked.

If IPv6 filter is preferred, you will be prompted by the following window. Enter the IPv6 address and
the two-digit prefix length to specify the range of IP addresses in your configuration.

Add ipv6 filter list

Filter address

Metwork address / Metwork mask: | | ! | |

[ ok [ cancel |

Range: This rule allows the user to assign a range of IP addresses to the Allow/Deny List.
Note: This rule only applies to IPv4 addresses.
For example:

Filter address

Rute:

IP address - IP address: | 102 168.2.0 | - | 192.168.2.255| |

ok J[ cancel |

Administrator IP address

Always allow the IP address to access this device: You can check this item and add the
Administrator’s IP address in this field to make sure the Administrator can always connect to the
device.

Always allow the IP address to access this device |

|’ Administrator IP address
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Security > IEEE 802.1X

Enable this function if your network environment uses IEEE 802.1x, which is a port-based network
access control. The network devices, intermediary switch/access point/hub, and RADIUS server
must support and enable 802.1x settings.

The 802.1x standard is designed to enhance the security of local area networks, which provides
authentication to network devices (clients) attached to a network port (wired or wireless). If all
certificates between client and server are verified, a point-to-point connection will be enabled; if
authentication fails, access on that port will be prohibited. 802.1x utilizes an existing protocol, the
Extensible Authentication Protocol (EAP), to facilitate communication.

m The components of a protected network with 802.1x authentication:

v e — [l

Supplicant Authenticator Authentication Server
(Network Camera) (Network Switch) (RADIUS Server)

-_

. Supplicant: A client end user (camera), which requests authentication.

2. Authenticator (an access point or a switch): A “go between” which restricts unauthorized end
users from communicating with the authentication server.

3. Authentication server (usually a RADIUS server): Checks the client certificate and decides

whether to accept the end user’s access request.

m VIVOTEK Network Cameras support two types of EAP methods to perform authentication: EAP-
PEAP and EAP-TLS.

Please follow the steps below to enable 802.1x settings:

1. Before connecting the Network Camera to the protected network with 802.1x, please apply
a digital certificate from a Certificate Authority (i.e., your network administrator) which can be
validated by a RADIUS server.

2. Connect the Network Camera to a PC or notebook outside of the protected LAN. Open the
configuration page of the Network Camera as shown below. Select EAP-PEAP or EAP-TLS as
the EAP method. In the following blanks, enter your ID and password issued by the CA, then
upload related certificate(s).

Enable IEEE 802.1x _ _
The maximum length of password is 200

EAP method: EAP-PEAR + symbols.

Identity: | |

| |

CA certificate: | [ Browse.. [ Upload
Status: nofile [ Remove |
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— IEEE 802.1x

Enable 802.1x

EAP method: EAP-TLS  »

|dentity:

|
Private key passord: | |
|

CA certificate: [ Browse.. || Upload
Status: no file [ Remove |
client certificate: | [ Browse.. || Upload
Status: nofile [ Remove |
Client private key: | [ Browse.. || Upload
Status: nofile [ Remove |

3. When all settings are complete, move the Network Camera to the protected LAN by connecting
it to an 802.1x enabled switch. The devices will then start the authentication automatically.

4 NoTE:

» The authentication process for 802. 1x:

1. The Certificate Authority (CA) provides the required signed certificates to the Network Camera
(the supplicant) and the RADIUS Server (the authentication server)

2. A Network Camera requests access to the protected LAN using 802.1X via a switch (the
authenticator). The client offers its identity and client certificate, which is then forwarded by the
switch to the RADIUS Server, which uses an algorithm to authenticate the Network Camera and
returns an acceptance or rejection back to the switch.

3. The switch also forwards the RADIUS Server'’s certificate to the Network Camera.

4. Assuming all certificates are validated, the switch then changes the Network Camera’s state to
authorized and is allowed access fo the protected network via a pre-configured port.

Certificate Authority
(CA)

Certificate Certificate

9
" -0» 1.

VIVOTEK |<: Network Switch RADIUS Server

Network Camera

Protected LAN
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Security > Miscellaneous

The embedded TrendMicro utitlity provides the protection against Cross-Site Request
Forgery. Cross-site request forgery is also known as one-click attack or session riding and
is abbreviated as CSRF. CSRF is a type of malicious exploit of a website, in this case, the
camera. Unauthorized commands are transmitted from a user that the web application
trusts, using the mechanism of forging a trusted user's own request with a request
containing his own cookies, etc. Different ways can be used for a malicious website to
transmit such commands. They can be specially-crafted image tags, hidden forms, and
JavaScript XMLHttpRequests. The malicious attack can occur without users' interaction or
even knowing it.

— Miscellaneous

Enable Cross-Site Request Forgery(CSRF) protection.

We strongly recommend not to disable this protection. Disabling this feature will expose your
camera to risks.
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PTZ > PTZ settings

This section explains how to control the Network Camera’s Pan/Tilt/Zoom operation.

Digital: Control the e-PTZ operation. Within a field of view,it allows users to quickly move the
focus to a target area for close-up viewing without physically moving the camera.

Digital PTZ Operation (E-PTZ Operation)

The e-PTZ control settings section will be displayed as shown below:

Digital

Selectstream: 1 =
2019/05/20 09:57:30
[« ][ Home J[ » |
zoom (2]
Pan speed: 0 -
Tilt speed: o -
Zoom speed: [ ¢
Auto pan/patrol speed: 1 =
Go to:
— Selectone - -
— Home locatiom setiings
| selcurentposiionashome || Resbrehome positionts default
— Preset and patrol settings
Name:| Add preset location Select Preset Locations for Patrol
User preset locations Patrol locations Ml(l::';
lower left i upper left 5 -
center et 5 B
right B B owerter 5
upper right center 5
lower right 3 right 5 4
&] [ Remove ] [Ilure]
— Misc settings
Zoom factor display
| s ||

For e-PTZ related details, please refer to page 137.

Auto pan/patrol speed: Select the speed from 1~5 (slow/fast) to set up the Auto pan/patrol speed control.

Zoom factor display

If you check this item, the zoom indicator will be displayed on the home page when you zoom in/out the
live viewing window as shown on the next page.

When completed with the e-PTZ settings, click Save to enable the settings on this page.
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Home page in the E-PTZ Mode

VIVOT=K IB9391-EHTV-v2
Profile name: | Live v | CITTEE Client settings | Configuration | Language

- Manual triggers:
1

m The e-Preset Positions will also be displayed on the home page. Select one from the drop-down
list, and the Network Camera will move to the selected position.

m If you have set up different preset positions for different streams, you can select one of the video
streams to display its separate preset positions.

Global View

In addition to using the e-PTZ control panel, you can also use the mouse to drag or resize the
floating frame to pan/tilt/zoom the viewing region. The live view window will also move to the
viewing region accordingly.

Moving Instantly

If you check this item, the live view window will switch to the new viewing region instantly after you
move the floating frame. If not selected, the process of moving from one position to another will be
shown.

Click on Image
The e-PTZ function also supports “Click on Image*“. When you click on any point of the Global View
Window or Live View Window, the viewing region will also move to that point.

Note that the’Click on Image” function only applies when you have configured a smaller “Region
of Interest” out of the maximum output frame! e.g., an 800 x 600 region from out of the camera’s
maximum frame size.

Patrol button: Click this button, then the Network Camera will patrol among the selected preset
positions continuously.
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Patrol settings

You can select some preset positions for the Network Camera to patrol.
Please follow the steps below to set up a patrol schedule:

1. Select the preset locations on the list, and click [>].
2. The selected preset locations will be displayed on the Patrol locations list.

3. Set the Dwelling time for the preset location during an auto patrol.
4. If you want to delete a preset location from the Patrol locations list, select it and click Remove.

5. Select a location and click | a [ ¥ ] to rearrange the patrol order.
6. Select patrol locations you want to save in the list and click Save to enable the patrol settings.

7. To implement the patrol schedule, please go to homepage and click on the Patrol button.

Digital

Selectstream:

2019/3/20 09:57:30 |I|

=R Home L

I:l Zoom

Fan speed:

Tilt speed:

Zoom speed:

Aufo panipafrel speed:
Go to:
- Selectone -- A |

— Home location settings

Set current position as home | | Restore home position to default |

— Preset and patrol settings 9 e

Name: | Add preset location Select Preset Locations for Patrol
n User preset locations [] Patrol locations II [huell{:::;
upper laft A [] upperleft ] A
left [] teft 5
lower left [] 1owerleft 5
cantar [] center 3
- W
right ] right 5 v
[bre] | Tromons [ [v] o
— Misc settings n i
Zoom factor display 6
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* The Preset Positions will also be displayed on the Home page. Select one from the Go to
menu, and the Network Camera will move to the selected preset position.
» Click Patrol: The Network Camera will patrol along the selected positions repeatedly.
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Event > Event settings

This section explains how to configure the Network Camera to respond to particular situations
(event). A typical application is that when a motion is detected, the Network Camera sends
buffered images to an FTP server or e-mail address as notifications. Click on Help, there is
an illustration shown in the pop-up window explaining that an event can be triggered by many

sources, such as motion detection or external digital input devices. When an event is triggered,
you can specify what type of action that will be performed. You can configure the Network
Camera to send snapshots or videos to your email address or FTP site.

Event
Hame Status Sun Mon Tue Wed Thu Fri Sat Time Trigger
Add | Hetp
close or EscKey

Event Trigger — Action (What to do)

Motion detection, Periodically,
Digital input, System boot

Media (What to send) Server (Where to send)

Ex

Snapshot, Video Clip, System log Email, FTP, HTTP Server,
Metwork storage

Event

To configure an event with reactive measures such as recording video or snapshots, it is necessary to
configure the server and media settings so that the Network Camera will know what action to take (such
as which server to send the media files to) when a trigger is activated. An event is an action initiated by a
user-defined trigger source. In the Event column, click Add to open the event settings window. Here you
can arrange three elements -- Schedule, Trigger, and Action to set an event. A total of 3 event settings
can be configured.

Event

Hame Status Sun Mon Tue Wed Thu Fri Sat Time Trigger

[ Ass  Jted

Event name:| |

Enable this event

Prierity: Normal [«
Detect next motion detection or digital input aﬁersecond(s]

" Event Schedul

[¥] Sun Mon [7] Tue [¥] Wed [¥] Thu Fri [¥] Sat

Time

1. Schedule

l @ Always

© From to[hh mm]

2. Trigger

3. Action

Save event ] [ Close ]
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m Event name: Enter a name for the event setting.
m Enable this event: Select this checkbox to enable the event setting.

m Priority: Select the relative importance of this event (High, Normal, or Low). Events with a higher
priority setting will be executed first.

m Detect next motion detection or digital input after [ ] seconds: Enter the duration in seconds to pause
motion detection after a motion is detected. This can prevent event-related actions to take place too
frequently.

1. Schedule

Specify the period of time during which the event trigger will take effect. Please select the days of the
week and the time in a day (in 24-hr time format) for the event triggering schedule. For example, you
may prefer an event to be triggered only during the off-office hours.

2. Trigger

This is the cause or stimulus which defines when to trigger the Network Camera. The trigger source can
be configured to use the Network Camera’s built-in motion detection mechanism or external digital input
devices.

There are several choices of trigger sources as shown on the next page. Select the item to display the
detailed configuration options.

m Video motion detection
This option makes use of the built-in motion detection mechanism as a trigger source. To enable this
function, you need to configure a Motion Detection Window first. For more information, please refer to
Motion Detection on page 156 for details.

Marmal: doar

Profile: hallway

Maote: Please cnnﬁgurel Motion detection f rst

m Periodically
This option allows the Network Camera to trigger periodically for every other defined minute. Up to 999
minutes are allowed.

Trigger every ather minutes

m Digital input
This option allows the Network Camera to use an external digital input device or sensor as a trigger
source. Depending on your application, there are many choices with digital input devices on the market
which help detect changes in temperature, vibration, sound, light, etc.

m System boot
This option triggers the Network Camera when the power to the Network Camera is disconnected and
re-connected.

m Recording notify
This option allows the Network Camera to trigger when the recording disk is full or when recording
starts to overwrite older data.
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m Audio detection
A preset threshold can be configured with an external microphone as the trigger to system event. The
triggering condition can be an input exceeding or falling below a threshold. Audio detection can take
place as a complement to motion detection or as a method to detect activities not covered by the
camera's view.

m Camera tampering detection
This option allows the Network Camera to trigger when the camera detects that is is being tampered
with. To enable this function, you need to configure the Tampering Detection option first. Please refer
to page 159 for detailed information.

(®) Camera tampering detaction

Tampering detection [ | Too dark [ | Too bright [ ] Too blurry

Mote: Please configure Camera tampering detection first

m Manual Triggers
This option allows users to enable event triggers manually by clicking the on/off button on the
homepage. Please configure 1 to 3 associated events before using this function.

@MEHUEJTFIQQEF www-vnvn'r-s—c-cg
172 [3 Video Stream |1 v
« Manual Trigger:
1
2| an]
m Shock detection 3| an

A shock accelerometer comes with the camera. If impact to the camera occurs, such as someone tries
to destroy the camera, the impact can be detected and reported. The Shock detection configuration is
found in Configuration > Applications > Shock detection.

m VADP

It is presumed that you already uploaded and enabled the VADP modules before you can associatee
VADP triggers with an Event setting.

Click on the Set VADP Trigger button to open the VADP setup menu. The triggering conditions
available with 3rd-party software modules known as VADP will be listed. Use the arrow buttons to
select these triggers. Users may implant these modules for different purposes such as triggering
motion detection, or applications related to video analysis, etc. Please refer to page 163 for the
configuration options with VADP modules.

Set VADP Trigger

VADP Triggers Triggers for Event Settings

ManualTrigger
Triggerd
TriggerB
TriggerC

TriggerD

| Close [ sae |
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Once the triggers are configured, they will be listed under the VADP option.

@ VADP

TriggerD
Triggers
[¥] TriggerB

TriggerC

ManualTrigger TriggerD
TriggerA
TriggerB

TriggerC

3. Action
Define the actions to be performed by the Network Camera when a trigger is activated.

~ Action

[] Trigger digital output for seconds

Backup media ifthe network is disconnected

Server Media Extra parameter
£ —one—[=] sDiest View
HTTP  —None— [=]

Create folders by date time and hour automatically

o nas

Add server ° Add media O

View

m Backup media if the network is disconnected

Select this option to backup media file on SD card if the network is disconnected. This function
will only be displayed after you set up a network storage (NAS). The media to back up can
include snapshot images, video, or system logs depending on your event settings.

m Play audio clip:
A pre-loaded audio clip can be configured to be played when one triggering condition is met. For
example, playing a warning message to deter an intruder.

m Configure CameralLink

The camera can be associated with another camera with responsive actions. For example, if a
thermal camera detects some abnormal situations, e.g., a fire, the camera can tell another camera,
say, a PTZ camera to move to a preset position to observe the current situation.
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Add server

It is necessary to configure the server and media settings so that the Network Camera will know what
action to take (such as which server to send the media files to) when a trigger is activated. Click Add
server to open the server setting window. You can specify where the notification messages are sent to
when a trigger is activated. A total of 5 server settings can be configured.

There are four choices of server types available: Email, FTP, HTTP, and Network storage. Select the item
to display the detailed configuration options. You can configure either one or all of them.

| Add server | ‘ Add media O‘

Server name: | Email

Server type

@ Email
Sender email address: |Camera@\ﬂmtekcom |
Recipient email address: |recipient@\nvotekcom |
Sernver address: | Ms.vivotek.tw |

—

This server requires a secure connection (35L)
) FTP
) HTTP

Metwoark storage

[ Test ” Save senver ” Close

Server type - Email
Select to send the media files via email when a trigger is activated.

m Server name: Enter a name for the server setting.

m Sender email address: Enter the email address of the sender.

m Recipient email address: Enter the email address of the recipient.

m Server address: Enter the domain name or IP address of the email server.

m User name: Enter the user name of the email account if necessary.

m Password: Enter the password of the email account if necessary.

m Server port: The default mail server port is set to 25. You can also manually set another port.

If your SMTP server requires a secure connection (SSL), select This server requires a secure
connection (SSL).
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To verify if the email settings are correctly configured, click Test. The result will be shown in a pop-up
window. If successful, you will also receive an email indicating the result.

2 hitp:/197.168.5.1 21 fegi-binfadminiestserver.cgi . (1o || 2|[X) 2 http:4/192.168.5.121/cgi-binjedminftestserver.cgi - ... [ ]|01[%K]

The email hag been sent successfully. Error in sending email.

Click Save server to enable the settings.

Note that after you configure the first event server, the new event server will automatically display on the
Server list. If you wish to add other server options, click Add server.

Server WMedia Extra parameter
P o (=] shist i
Email | —None— [+]

||Mllsanmr (v ) ” Add media O‘
—

Server type - FTP
Select to send the media files to an FTP server when a trigger is activated.

Server name: | FTP |

Server Type

) Email

@ FTP
Server address: | ftp.vivotek.com
Server port
User name:
Password:
FTP folder name: |

Passive mode
) HTTP

) Network storage

m Server name: Enter a name for the server setting.
m Server address: Enter the domain name or IP address of the FTP server.

m Server port: By default, the FTP server port is set to 21. It can also be assigned to another port number
between 1025 and 65535.

m User name: Enter the login name of the FTP account.

m Password: Enter the password of the FTP account.

m FTP folder name

Enter the folder where the media files will be placed. If the folder name does not exist, the Network
Camera will automatically create one on the FTP server.
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m Passive mode

Most firewalls do not accept new connections initiated from external requests. If the FTP
server supports passive mode, select this option to enable passive mode FTP and allow data
transmission to pass through the firewall. The firmware default has the Passive mode checkbox
selected.

To verify if the FTP settings are correctly configured, click Test. The result will be shown in a pop-
up window as shown below. If successful, you will also receive a test.txt file on the FTP server.

2 hitp:#192.168.5.121/ogi-bindad minftestsorver.cgi - ... [m | 1|1X) A htp:#/192.168.5.121/ci binfad minftestserver.cgi- ... [ L1)[5)

ftp transmizsion successfully. ftp transmission failed.

Click Save server to enable the settings.

Server type - SFTP
Select to send the media files to an SFTP (Secure File Transfer Protocol) server when a trigger is
activated. This page contains the client side settings.

Server type

() Email

() FTP

@ SFTP
Server address: 192.168.5.114 |
Server port: IZI
Host key MDS5: Scanning... please wait | et |
Folder name: | ‘
Login mode: () Password (e Fublickey
User name: |.=_|dm'n |
Fairing mode: (@) Auto () Download () Upload
Password: | |

m Server address: Enter the SFTP server address in either the domain name or IP address.

m Server port: By default, the FTP server port is set to 22. It can also be assigned to another port number
between 1025 and 65535.

m Host key MD5: You have the option to use public/private key authentication instead of a username and
password to connect to the server. This option requires that you have a private/public SSH key pair,
and that the public key is in place on your SFTP server.

If you wish to Use key authentication for this SFTP server, click the Get (Read Fingerprint) button to
request the public key fingerprint from the server. The host key MD5 is a hash of the FTP server’s
public key, which the camera stores in order to verify that it is connecting to the correct SFTP server.
You can copy that fingerprint and save it for later reference.

The max. length of MD5 fingerprint is 47 characters.
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If key authentication is not preferred, you can specify a username and password in the section below.

An RSA key fingerprint will look like this: da:47:93:b4:3a:90:5b:50:1f:20:a8:f9:b7:a1:d0:e1. Verify if this
is the SFTP server you want to connect to.

#EHE x

Please confirm if the SFTP server( 192.168.5.114 ) is trustable far
you and the host key MD3
is: foee:0f268:30:71:fb:92:3Fb3:83:1d:90:18:c3:87.

BE || =

m Folder name

Enter the folder where the media file will be placed. If the folder name does not exist, the Network
Camera will create one on the SFTP server.

Use backslash “\” when you need to specify a path. Leave it blank to use the SFTP server’s default
root directory. The max. length of folder name is 128 characters.

m Login mode
Select a Login mode as either the Password or the Public key mode.

When using SFTP, you can authenticate using a public/private SSH key pair instead of a password.
If key authentication is not enabled, you need to specify a password instead. The administrator of the
SFTP server will need to manually add the corresponding public key to the SFTP server.

Password mode:
m User name: Enter the login name of the SFTP account.

m Password: Enter the password of the SFTP account.

JAddsenrer ‘ Add media €2

Use the Test button to test the connectivity. When

Server name: | SFTP done, enter the server name and click the Save server
Server type button to preserve your settings.
() Email
() FTP
@® SFTP sftp transmission successfully
Server address: [10.16.103.55 |
Server port:
Host key MD5: |38:00:54:83:7b:43:9c06:6a:76:ae | Get |
Folder name: | |
Login mode: (@) Password () Publickey

O HTTP

. Network storage

Test |[ saveserer || Close
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Publickey mode:

Selecting the Public key mode will bring up the Pairing mode options: Auto, Download, Upload.

Auto Camera will generate a key pair and auto pair public key with the SFTP
server.
Download Camera will generate a key pair and download the public key for the user to

upload it to the SFTP server. The supported formats are: ED25519 (default.
Elliptic curve signature scheme Edwards-curve Digital Signature Algorithm;
with faster key creation, encryption and decryption), RSA (Rivest-Shamir—
Adleman, with greater portability), ECDSA (Elliptic Curve Digital Signature
Algorithm).

Upload Upload the private key here and upload the public key to the SFTP server.

A private key is a guarded secret and it can be stored on disk in an encrypted
form. A passphrase is used in order to decrypt it. It is a login password to the
SSH server, the passphrase is only used to decrypt the private key on the
local system. The passphrase is not transmitted over the network.

When using SFTP, you can authenticate using a public/private SSH key pair instead of a password.
If key authentication is not enabled, you need to specify a password instead. The administrator of the
SFTP server will need to manually add the corresponding public key to the SFTP server.

The key benefit of a key-based authentication is that instead of a using a password, you are less

vulnerable to brute-force attacks and you do not expose valid credentials, if the server has been
compromised.

Server name:

Server type

) Email

() FTP

@ SFTP
Server address: 11921685114 |
Server port
Host key MD5: | I
Folder name: |
Login mode: () Password (@ Publickey air 3 [
User name: I:I download the public
Pairing mode: @® Auto () Dovmload (7 Upload key for the userto |
Password: upload it to the SFTP

Server.
() HTTP
 Network storage

Test | savesewer || Close
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Server type - HTTP
Select to send the media files to an HTTP server when a trigger is activated.

Server name: | HTTP |

Server Type
) Email
© FTP

@ HTTP

LIRL: | hitp:/192.168.5.10/cqgi-binfupload.cgi

) Metwork storage

m Server name: Enter a name for the server setting.
m URL: Enter the URL of the HTTP server.
m User name: Enter the user name if necessary.

m Password: Enter the password if necessary.

To verify if the HTTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will receive a test.txt file on the HTTP server.

3 hitp:#/192.168.5.121/cgi- binsadminftestserver.cgi - .. [ || |[3%)

3 hitp:#f192_168.5 121 /cgi-binfad minfie stsexver cgi - . |__

HTTP Transmission successfully. Thanks HTTP Transmission failed.

Click Save server to enable the settings.
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Network storage:
Select to send the media files to a networked storage when a trigger is activated. Please refer to NAS
server on page 169 for details. Note that only one NAS server can be configured.

Click Save server to enable the settings.

— Action

[] Trigger digital output for I:l seconds
Backup media if the network is disconnected

Server Media Extra parameter
© | —tine— () e v
Email  —None— [=]
FTP ——None—- =]
HTTP | —None— =]

Create folders by date time and hour automatically

s

| Add server OH Add media O‘

View

|  cClose || saveevent

m SD Test: Click to test your SD card. The system will display a message indicating the result as a
success or a failure. If you want to use your SD card for local storage, please format it before use.
Please refer to page 151 for detailed information.

m View: Click this button to open a file list window. This function is only for SD card and Network Storage.
If you click the View button for an SD card, a Local storage page will prompt so that you can manage
the recorded files on SD card. For more information about Local storage, please refer to page 171.
If you click the View button for a Network storage, a file directory window will prompt for you to view
recorded data on Network storage. For detailed illustration, please refer to the next page.

m Create folders by date, time, and hour automatically: If you select this item, the system will
automatically create folders by the date when video footages are stored onto the networked storage.

The following is an example of a file destination with video clips:

[] /120190120 The format is: YYYYMMDD
] 5/20190121 Click to open the directory

] # 20190122

[ Delete | [ Deleteal |——Click to delete all recorded data

Click to delete selected items
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Click 20190120 to open the directory:

The format is: HH (24r)
Click to open the file list for that hour

< 07 03 09 10 11 12 13 14 15 16 17 =

file name size date time
[]|Recordingl 58.mp4| 2526004 2019/01/20 07/58]28
[]|Recordingl 59.mp4| 2563536 2019/01/20 0759 28

| DelletE | | Deleteal | | Back |

1
Click to delete Click to go back to the previous
selected items level of the directory

Click to delete all
recorded data

< 07 03 09 10 11 12 13 14 15 16 17 =

file name | size date time
[]|Recording1 5ﬂ.mpA| 2526004 2019/01/20 07:58:28
[]|Recordingl 59.mﬂ| 2563536 2019/01/20 07:59:28

[ Delete | [ Deleteall | | Back |

The format is: File name prefix + Minute (mm)
You can set up the file name prefix on Add media page. Please
refer to next page for detailed information.
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Add media

Click Add media to open the media setting window. You can specify the type of media that will be
sent when a trigger is activated. A total of 5 media settings can be configured. There are three choices
of media types available: Snapshot, Video Clip, and System log. Select the item to display the detailed
configuration options. You can configure either one or all of them.

Add server &0 | Add media

— Media type
Aftached media:

@ Snapshot

Send pre-event image(s) [0~7]
send post-eventimage(s) [0~7]

File name prefix: |Sn apshot_

) Video clip

) Bystem log

Savemedia | |  Close

Media type - Snapshot
Select to send snapshots when a trigger is activated.

m Media name: Enter a name for the media setting.

m Source: Select to take snapshots from any of the video streams.

m Send [] pre-event images
The Network Camera has a buffer to temporarily hold data up to a certain limit. Enter a number to
decide how many images to capture before a trigger is activated. Up to 7 images can be generated.

m Send [ ] post-event images

Enter a number to decide how many images to capture after a trigger is activated. Up to 7 images can
be generated.

For example, if both the Send pre-event images and Send post-event images are set to 7, a total of 15
images can be generated after a trigger is activated.

Trigger Activation

m File name prefix
Enter the text that will be appended to the front of the file name.
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m Add date and time suffix to the file name
Select this option to add a date/time suffix to the file name.
For example:

Snapshot_20190513_100341

t1

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Click Save media to enable the settings.

Note that after you set up the first media server, a new column for media server will automatically display
on the Media list. If you wish to add more media options, click Add media.

Media type - Video clip

Select to send video clips when a trigger is activated.

Media name: Video Clip |
~ Media Type

Attached media:

) Snapshot

@ Video Clip

Pre-event recording: D seconds [0~9]

Maximum duration: seconds M=~20]
Maximum file size: Khytes [50~4096]
File name prefix | Video Clip_|

) System log

| Savemedia |[  Close

m Media name: Enter a name for the media setting.
m Source: Select a video stream as the source of video clip.

m Pre-event recording
The Network Camera has a buffer to temporarily hold data up to a certain limit. Enter a number to
decide the duration of recording before a trigger is activated. Up to 9 seconds can be set.

m Maximum duration
Specify the maximum recording duration in seconds. The duration can be up to 10 seconds.
For example, if pre-event recording is set to five seconds and the maximum duration is set to ten
seconds, the Network Camera continues to record for another 4 seconds after a trigger is activated.

OCQQQ?QQOQ

Trigger Activation
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m Maximum file size
Specify the maximum file size allowed. Some users may need to stitch the video clips together when

searching and packing up forensic evidence.

m File name prefix
Enter the text that will be appended to the front of the file name.

For example:

Video_20190513_100341

tt

File name prefix Date and time suffix
The format is: YYYYMMDD_HHMMSS

Click Save media to enable the settings.

Media type - System log
Select to send a system log when a trigger is activated.

Media name:| System log|

~ Media Type
Attached media:
) Snapshot
) video Clip
@ System log

| savemeda |  Close

Click Save media to enable the settings, then click Close to exit the page.

— Action
Backup mediaifthe network is disconnected
Server Media Extra parameter

s SDtest View

mail
—Mong—
email
log
snapshot

Save event H Close
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In the Event settings column, the Servers and Medias you configured will be listed; please make sure the
Event -> Status is indicated as ON, in order to enable the event triggering action.

When completed, click the Save event button to enable the settings and click Close to exit Event
Settings page. The new Event / Server settings / Media will appear in the event drop-down list on the
Event setting page.

Please see the example of the Event setting page below:

— Ewvent
HName Status Sun Mon Tue Wed Thu Fri Sat Time Trigger
event1 ON Yoo v v N YV 00000~24:00 seq Delete

| hed Jhen

- Server settings

Hame Type Address/Location
HITP http http:i192.168.5.10 Delete
- Media
Available memory space: 13000KB

Hame Type
Snapshot snapshot Delete
Video clip videoclip Delete
System log systemlog Delete

— Customized script

Hame Date Time

When the Event Status is ON, the event configuration above is triggered by motion detection, the
Network Camera will automatically send snapshots via e-mail.

If you want to stop the event trigger, you can click on the ON button to turn it to OFF status or click the
Delete button to remove the event setting.

To remove a server setting from the list, select a server name from the drop-down list and click Delete.
Note that you can only delete a server setting when it is not applied in an existing event setting.

To remove a media setting from the list, select a media name from the drop-down list and click Delete.
Note that you can only delete a media setting when it is not applied in an existing event setting.
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Customized Script

This function allows you to upload a sample script (.xml file) to the camera, which will save your time on
configuring the settings. Please note that there is a limited number of customized scripts you can upload;
if the current amount of customized scripts has reached the limit, an alert message will prompt. If you
need more information, please contact VIVOTEK technical support.

«~ Customized Script

20190213 18:13:46
20190213 18:11:32

Click to upload a file ——{Add]|user1 v|[ Delete |

<?xml version="1.0" encoding="UTF-8"2>
<eventmgr version="0102">
<maxprocess>l</maxprocess>
<!-- from 08:30:00-20:30:00 on Monday to Friday every week -—->
<schedule id="0">
<duration>
<weekday>1-5</weekday>
<time>08:30:00-20:30:00</time>
</duration>
</schedule>
<l-- Motion —->
CIICk to mOdIfy the <motion condition=ro">
<status id="0">trigger</status>

H t I 4»““:“3 id="1">trigger</status>
Script online </motions
<event id="0">
<descriptionyMail system log to email adddress</description
<condition»c0</condition>
<scheduleno>0</schedulenc>
<delay>10</delay>
<!-- users can send email with title "Motion" tTo recipient pudding.vang@vivotek.com. The body
of mail is the log messages ——>
<process>
Jusx/bin/smtpclient -3 "Motion" -f IP713%@vivotek.com -b Svar/log/messages -5 ms.vivotek.tw -
M 3 pudding.vang@vivotek.com
</process>
<priority>0</pricrity>
</event>
</eventmgr>

[E3

Upload
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Applications > Motion detection

The camera comes with a Smart Motion Detection utility as its pre-loaded VCA package. Please
refer to its User Guide for more information:

http://download.vivotek.com/downloadfile/solutions/vadp/smart-motion-detection-manual_
en.pdf.

Click on Configuration > Applications > Motion detection. The Smart Motion utility will be
automatically started.

If Human detection is applied, make sure you measured the height of your camera at the
installation site. It is important for a correct video analysis. You should enter the installation
height in the Motion detection Settings page.

@«  1B9387-H ‘Smart Motion Detection = ain Scheduled
© Motion Window 0 [i]
X
BN — -
. ]
Set up camera installation Create motion windows Adjust sensitivity Set trigger level
(Human detection only)

Timefiter @ @D

Minimum activity duration 500  |ms(range)

Activity merge interval 1500 |ms{range)

Save Discard

@ 1B9387-H ‘Smart Motion Detection H Main Scheduled o
